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EMENTA DA DISCIPLINA 

OBJETIVOS: 

Permitir que o aluno inicie contato com ambientes de representação digital 2D, chamados CAD 

(Computer Aided Design ou Desenho Assistido por Computador) a fim de que ao final do curso ele 

seja capaz de utilizar uma das ferramentas CAD para se expressar graficamente.  

CONTEÚDO: 

1. INTERFACE GRÁFICA: Quick Access, Barra de menu, Menu Browser, Ribbons, Barra de 
Status, Modos de seleção, Ferramentas de navegação: ZOOM e PAN. 

2. COORDENADAS  CARTESIANAS  (RETANGULARES)  2D:  Coordenadas  absolutas  e 
Coordenadas relativas. 

3. COORDENADAS POLARES 2D: Coordenadas Polares Absolutas e Coordenadas polares 
relativas. 

4. ABA  HOME  >  DRAW:  Principais  ferramentas  de  desenho  (Line,  polyline,  rectangle, 
circle, arc, polygon, ellipse, spline, point, divide, measure, hatch). 

5. ABA  HOME  > MODIFY:  Principais  ferramentas  de modificação  (Move,  Copy,  Array, 
Rotate, Mirror, Offset, Fillet, Chanfer, Trim, Extend, Stretch, Scale, Align). 

6. ABA HOME > LAYERS: Principais comandos para organização do desenho em camadas 
–  Layers  (Layer  Properties, Make  Objects  Layer  Current,  Isolate,  Unisolate,  Freeze, 
Thaw All Layers, Off, On, Lock, Unlock). 

7. ABA  HOME  >  PROPERTIES:  Principais  propriedades  dos  objetos  (Object  Color, 
Lineweight, Linetype, Ltscale, List, Area). 

8. ABA  INSERT:  Blocos  (Create  Block,  Insert  Block,  Block  Editor,  Edit  Block  In‐Place), 
Imagens. 

9. ABA ANNOTATE: Principais ferramentas de anotação, como cotas e textos. 

10. ABA OUTPUT: Configurações de  impressão  (Criando uma prancha no model, Criando 
uma prancha no layout). 

AVALIAÇÃO: 

Serão avaliados exercícios direcionados a serem desenvolvidos em sala, e o produto  final de 

um exercício que será desenvolvido no decorrer da disciplina onde os alunos deverão representar 

um projeto arquitetônico e gerar um PDF da prancha com o mesmo. 

Os exercícios direcionados terão peso 2,5 e o trabalho final peso 7,5. 
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1. INTERFACE GRÁFICA 

A organização do espaço de trabalho do AutoCAD se assemelha muito a dos 
softwares da Microsoft Office (Word, Excel, PowerPoint) nos quais os comandos são 
organizados em abas chamadas Ribbons. 

 

 

 

 QUICK ACCESS 

 

Nesta barra são mostrados ícones de comandos mais utilizados e que sempre 
serão exibidos. 

 New – Abre um novo arquivo. 
 Open – Abre um arquivo salvo. 
 Save – Salva o arquivo. 
 Save As – Salvar como. 
 Cloud Options: Salva ou atualiza uma cópia do arquivo no servidor da 

sua conta no Autodesk 360. 

Quick Access 

Menu Browser 
Ribbons 

Barra de menus 

Palettes 

Ícone UCS 

Barra de 
comandos

Barra de 
status 

Área gráfica 

View Cube 

Navigate Bar 
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 Plot – Abre a janela de opções de plotagem. 
 Undo – Desfaz o último comando. 
 Redo – Refaz o último comando desfeito. 
 Workspace – Mostra opções de organização da área de trabalho. 

É possível editar esta barra clicando sobre ela com o botão direito do mouse. 

 
 

 Remove from Quick Access Toolbar - Remove um botão de comando 
da barra Quick Access. 

 Add Separator - Adiciona uma linha de separação após o botão 
escolhido. 

 Customize Quick Access Toolbar - Mostra o quadro de diálogo 
“Customize User Interface (CUI)”, de onde se pode adicionar botões 
às barras de ferramentas. 

 Show Quick Access Toolbar below the Ribbon - Move a barra Quick 
Access para baixo da Ribbon. 

É possível clicar no botão abre-lista (pull down) à direita da barra de 
ferramentas Quick Access, onde se encontram opções para adicionar mais 
botões de comandos também muito utilizados no AutoCAD, como Match 
Properties, Plot Preview, Properties, entre outros. 
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 BARRA DE MENUS 

Nesta barra se encontram praticamente todos os comandos do AutoCAD. São 
os mesmos menus e organização existentes nas versões anteriores do 
programa. 

Ao iniciar o AutoCAD após instalar a barra de menus não estará visível. Para 
isso é preciso clicar no pull-down do Quick Access e clicar em Show menu bar. 
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 MENU BROWSER 

Também conhecido como Application Menu permite buscar comandos assim 
como encontrar os comandos essenciais como criar um novo arquivo, salvar, 
abrir, exportar, plotar e publicar. 

 

 RIBBONS 

As ribbons são um conjunto de abas e painéis onde pode-se acessar os 
comandos do AutoCAD. Cada aba contém vários painéis e cada painel contém 
várias ferramentas. Alguns painéis podem se expandir para se acessar outras 
ferramentas. 

Foi uma maneira de se organizar os comandos criada a partir da versão 2010 
do programa. 

Existem 11 ribbons separadas por abas: 

 Home 
 Insert 
 Annotate 
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 Layout 
 Parametric 
 View 
 Manage 
 Output 
 Plug-ins 
 Online 
 Express Tools (na versão FULL) 

Outras surgem de acordo com o objeto que se está manejando, como imagens, 
blocos, etc. 

As Ribbons são divididas da seguinte forma: 

 

 

Dentro das abas (1) os comandos são separados em painéis. Alguns poderão 
ser expandidos exibindo mais comandos clicando na seta para baixo (2). Para 
deixar esta expansão fixa e visível basta clicar no pin (3). 

  

1 

3 
2 
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 BARRA DE STATUS 

A barra de status está localizada na base inferior da janela do aplicativo. 

 

 

 

Esta barra pode ser dividida em 3 partes: 

1 - À esquerda é possível visualizar as coordenadas X, Y e Z do cursor. 

2 – Na parte central estão localizadas as ferramentas de assistente de 
desenho. 

3 – À direita são encontradas ferramentas de visualização, algumas 
opções de configuração, e ferramentas escala anotativa. 

  

1 2 3 
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 As ferramentas de assistente de desenho são: 

 

  Infer Constraints: Pode-se aplicar automaticamente as restrições 
ao criar e editar objetos geométricos. 

  Snap Mode (F9): Permite modular o movimento do cursor nos 
eixos X e Y de acordo com a configuração desejada. 
 

 
 

  Grid (F7): Habilita uma grade no desenho para auxílio de 
desenho, como uma folha de papel milimetrado. Assim como o snap é 
possível configurar o tamanho dos quadrados da grade. 

  Ortho (F8): É uma das ferramentas mais utilizadas. Com ela 
ativada, por exemplo, ao se desenhar uma linha ela automaticamente 
ficará travada na posição do eixo X ou do Y, permitindo desenhar 
facilmente de forma ortogonal. 

  Polar (F10): Assim como a ferramenta ortho, ao se desenhar, ela 
trava a direção das linhas em angulações definidas, como 30º, 45º, 
60º, etc. 

  Object Snap (F3): Também conhecido como Osnap, ele permite 
que o cursor busque automaticamente pontos específicos dos 
objetos, como endpoints, midpoints, etc.  
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  3D Object Snap (F4): Tem a mesma função do Osnap porém em 
objetos 3D. 

  Object Snap Tracking (F11): Conhecido como Otrack, permite 
que se desenhe tendo como base outros objetos. 

  Allow/Disallow Dynamic UCS (F6): Permite o uso de UCS 
dinâmico no modo tridimensional. 

  Dynamic Imput (F12): Ativa ou desativa a exibição de entrada 
dinâmica na área de trabalho. Quando estiver ativada, várias 
informações aparecem ao lado do cursor. 

 

  Show/Hide Lineweigth: Habilita a visualização das espessuras 
das linhas do desenho. 

  Show/Hide Transparency: Habilita a visualização de 
transparência. 

  Selection Cycling (Ctrl+w): Esta opção é bastante útil. Uma vez 
ativada ela permite que seja escolhido que objeto será selecionado ao 
se tentar selecionar objetos sobrepostos. 

  Annotation Monitor: Esta opção verifica se cotas estão 
desassociadas de objetos. Estando ativada, as cotas que estiverem 
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desassociadas de objetos aparecerão com um quadrado amarelo com 
uma exclamação. 

As ferramentas situadas à direita da barra de status são: 

 

 

  Quick View Layouts: Exibe uma pré-visualização em miniatura 
dos Layouts existentes no desenho, permitindo alternar entre eles e 
selecioná-los. 

  Quick View Drawings: Exibe uma pré-visualização dos arquivos 
(desenhos) abertos, permitindo alternar entre eles e selecioná-los. 

  Annotation Scale: Mostra a escala do desenho atual, em 
“Model Space” ou dentro de “Viewports”. 

  Annotation Visibility: Mostra objetos anotativos de todas 
escalas ou apenas da escala selecionada no momento. 

  Workspaces: Permite alternar entre diferentes “espaços de 
trabalho” e personalizar e salvar sua própria organização. 

 Display Locking: Trava a posição atual das barras de 
ferramentas e janelas. 

  Hardware acceleration: Ativa ou desativa a aceleração do 
programa utilizando mais memória do computador. Normalmente em 
notebooks esta opção inicialmente está desligada e pode parecer que 
o programa fica “travando”, por exemplo ao desenhar um linha. 

  Application Status Bar Menu: Ativa o menu da barra de status 
onde se pode configurar os itens que serão mostrados na barra. 

  Clean Screen: Maximiza a área gráfica, ocultando todas as 
barras de ferramentas. 

 MODOS DE SELEÇÃO 

Existem algumas maneiras de selecionar objetos. Uma é clicando sobre cada 
objeto e a segunda é utilizando a seleção retangular, onde é possível selecionar 
vários elementos de uma só vez. 

Para a seleção retangular existem duas formas: 

 Window: seleção feita da esquerda para direita, com área de 
seleção azul. Desta forma, somente os objetos que estiverem 
totalmente contidos na janela serão selecionados. 
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 Crossing: seleção feita da direita para esquerda, com área de 
seleção verde e contorno tracejado. Desta forma, todos os objetos 
que estiverem totalmente contidos e todos objetos que estiverem 
sendo cortados pela borda da janela serão selecionados. 

 

Para retirar a seleção de uma entidade de um grupo selecionado mantenha o 
botão SHIFT pressionado e clique nesta entidade ou abra janela de seleção. 

 FERRAMENTAS DE NAVEGAÇÃO: 

Para navegar na área de trabalho existem duas ferramentas principais: zoom e 
pan. 

 ZOOM 
Botão Comando Atalho Menu Ribbon 

 Zoom Z View>Zoom View>Navigate 2D 

Essa ferramenta é utilizada para se aproximar ou se afastar do desenho e 
existem várias maneiras de utilização. 

A mais comum é utilizando o botão scroll do mouse. Rodando-o para cima o 
desenho é aproximado e para baixo é afastado. 

As outras formas são: 

 Zoom window: permite ao usuário ampliar áreas específicas, de forma 
rápida e prática, usando apenas a informação de dois pontos opostos em 
uma janela retangular. 

 Zoom Extents: usado para visualizar toda a extensão do desenho na 
área gráfica, incluindo Layers desligados (não visíveis). Também pode-
se acioná-lo facilmente clicando 2 vezes o botão central do mouse 
(Scroll). 

Objeto selecionado 

Objeto selecionado 
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 Zoom Previous: permite ao usuário retornar à visualização anterior, com 
um limite máximo de 10 retornos. 

 Zoom Realtime: é semelhante ao zoom que se usa rodando o scroll do 
mouse, ou seja, arrastando-o em uma linha vertical para cima amplia a 
vista e para baixo reduz. Sua vantagem sobre o scroll do mouse é a 
maior precisão. 

 PAN 
Botão Comando Atalho Menu Ribbon 

 
Pan P View>Pan View>Navigate 2D 

Permite ao usuário reposicionar a vista na área do desenho para que se 
visualizem detalhes que estavam fora dos limites atuais da área gráfica. 

Pode-se utilizar o Pan sem acessar o comando pressionando o botão central 
do mouse (Scroll) e arrastando. 
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2. COORDENADAS CARTESIANAS 2D 
 

O software AutoCAD baseia-se em um sistema de coordenadas cartesianas (três 
eixos, X, Y e Z). Ao inserir valores de coordenada, indica-se a distância de um ponto e 
sua direção (+ ou -) juntamente com os eixos X, Y e Z relativos à origem do sistema de 
coordenadas (0,0,0). 

Em 2D, especifica-se pontos no plano XY, também chamado de plano de trabalho. O 
plano de trabalho é similar a uma folha plana de papel quadriculado. O valor X de uma 
coordenada cartesiana especifica a distância horizontal e o valor Y especifica a distância 
vertical. O ponto de origem (0,0) indica a localização de intersecção dos dois eixos. 

 

É possível utilizar coordenadas cartesianas (retangulares) absolutas ou relativas 
para localizar pontos ao criar objetos. Para usar coordenadas Cartesianas para 
especificar um ponto, insere-se um valor para X e um valor para Y, separados por uma 
vírgula (X,Y). O valor X é a distância positiva ou negativa, em unidades, ao longo do eixo 
horizontal. O valor Y é a distância positiva ou negativa, em unidades, ao longo do eixo 
vertical. 

IMPORTANTE: 
 

- A orientação X sempre será na horizontal 
- Para direita valores positivos (+). 
- Para esquerda valores negativos (-). 
- A orientação Y sempre será na vertical 
- Para cima – valores positivos (+). 
- Para baixo valores negativos (-). 
- Os pares ordenados sempre X é o primeiro termo 

e Y o segundo. (X,Y) 
- A configuração sempre será pela orientação do 

plano cartesiano, seguindo o padrão matemático dos 
quadrantes tanto para as coordenadas absolutas 
quanto para as relativas, isto é: 

 
 

   DICA: 

No AutoCAD, a vírgula SÓ é 
utilizada para separar os pontos 
das coordenadas (X,Y). Para a 
inserção de números quebrados, 
deve-se utilizar o 
ponto.Ex.:37.24 -102.45 –etc...  
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     2º Quadrante (-X,+Y)                                                   1º Quadrante (+X,+Y)                           

 

  3º Quadrante (-X,-Y)                                                       4º Quadrante (+X,-Y) 

 COORDENADAS ABSOLUTAS 

As coordenadas absolutas têm base na origem UCS (0,0), que é a intersecção 
dos eixos X e Y. Usa-se coordenadas absolutas quando os valores precisos de 
X e Y das coordenadas do ponto são conhecidos. 

Com a entrada dinâmica (Dynamic Imput – atalho F12), especifica-se as 
coordenadas absolutas com o prefixo #. Por exemplo, ao inserir #3,4, um 
ponto de 3 unidades ao longo do eixo X e 4 unidades ao longo do eixo Y são 
especificados a partir da origem UCS. 

O exemplo a seguir desenha uma linha iniciando em um valor de -2 no eixo X, e 
um valor de 1 no eixo Y, e um ponto final em 3,4.  

 

 Comando L (ENTER)  

 Do ponto: #-2,1 

 Para o ponto: #3,4 

 

 COORDENADAS RELATIVAS 

As coordenadas relativas se baseiam no último ponto inserido. Usa-se 
coordenadas relativas quando a posição de um ponto em relação ao ponto 
anterior é conhecida. 

Para especificar coordenadas relativas, precede-se os valores de coordenada 
de um símbolo @ (quando Dynamic Imput – F12 estiver desligado). Por 
exemplo, inserindo @3,4 especifica-se um ponto de 3 unidades ao longo do 
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eixo X e 4 unidades ao longo do eixo Y, relativo ao do último ponto 
especificado. 

 
 

@ VALOR EM X , VALOR EM Y 

 

O exemplo a seguir desenha os lados de um triângulo. O primeiro lado consiste 
em uma linha iniciando nas coordenadas absolutas -2,1 e terminando em um 
ponto de 5 unidades na direção do eixo X e 0 unidades na direção do eixo Y. O 
segundo lado consiste em uma linha iniciando no ponto final da primeira linha e 
terminando em um ponto de 0 unidades na direção do eixo X e 3 unidades na 
direção do eixo Y. O segmento da linha final usa coordenadas relativas para 
retornar para o ponto inicial. 

 

 Comando: L (ENTER)             

 Do ponto: #-2,1 

 Para o ponto: @5,0 

 Para o ponto: @0,3 

 Para o ponto: @-5,-3 

 

 
  

   DICA: 

Para fechar qualquer poligonal, ao invés de digitar os valores das coordenadas do ponto 
inicial, pode-se digitar C (ENTER).  
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3. COORDENADAS POLARES 2D 

As coordenadas polares (distância e ângulo) absolutas ou relativas são utilizadas 
para localizar pontos ao criar objetos. 

Para usar coordenadas polares para especificar um ponto, insere-se a distância e um 
ângulo separados por um sinal de menor que (<). 

 

 
 

Por padrão, os ângulos aumentam no sentido anti-horário e diminuem no sentido 
horário. Para especificar a direção de sentido horário, insere-se um valor negativo para o 
ângulo. Por exemplo, inserindo 1<315, localiza o mesmo ponto como inserindo 1<-45. 

 
 
 

 COORDENADAS POLARES ABSOLUTAS 
 

Coordenadas polares absolutas são medidas da origem UCS (0,0), que é a 
intersecção dos eixos X e Y. Usa-se as coordenadas polares absolutas quando  
as coordenadas de distância e ângulo precisas do ponto são conhecidas. 

Com a Entrada dinâmica (F12) ligada, pode-se especificar coordenadas 
absolutas com o prefixo #. Ao inserir coordenadas na linha de comando ao 
invés de no dynamic imput, o prefixo # não é usado. Por exemplo, inserindo 
#3<45 especifica-se um ponto de 3 unidades da origem de um ângulo de 45 
graus do eixo X. 

O exemplo a seguir mostra duas linhas desenhadas com coordenadas polares 
absolutas, utilizando-se a definição padrão de direção de ângulo: 
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 Comando: L (ENTER) 

 Do ponto: #0,0 

 Para o ponto: #4<120 

 Para o ponto: #5<30 

 COORDENADAS POLARES RELATIVAS 

As coordenadas relativas se baseiam no último ponto inserido. Usa-se 
coordenadas relativas quando a posição de um ponto em relação ao ponto 
anterior é conhecida. 

Para especificar coordenadas relativas, precede-se os valores de coordenada 
de um símbolo @ (desde que o Dynamic Imput esteja desligado, caso contrário 
não precisa). Por exemplo, inserindo-se @1<45 especifica-se um ponto com 
uma distância de 1 unidade do último ponto especificado com um ângulo de 45 
graus do eixo X. 

O exemplo a seguir mostra duas linhas desenhadas com coordenadas polares 
relativas. Em cada ilustração, a linha inicia-se no local legendado como o ponto 
anterior: 

 

 Comando: L (ENTER) 

 Especificar um ponto inicial aleatório 

 Do ponto: @3<45 

 Ao ponto: @5<285 
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4. RIBBON HOME > DRAW 

 

Com esta Ribbon é possível desenhar linhas retas, curvas, formas geométricas, 
hachuras, tabelas, entre outros.  

 LINE 
Botão Comando Atalho Menu Ribbon 

 
Desenhar linha L Draw>line Home>draw 

O comando LINE gera um segmento de linha reta que une dois ou mais pontos. 
Esses pontos são especificados usando coordenadas bidimensionais ou 
tridimensionais. É possível criar uma série de segmentos de linha contíguos. 
Cada segmento é um objeto de linha que pode ser separadamente editado. 

L (ENTER) 
Os seguintes prompts são exibidos: 

 Specify first point: Especifique um ponto ou pressione ENTER para 
continuar a partir da última linha ou arco de desenho; 

 Specify next point or [Close/Undo]: Especifique o próximo ponto ou 
acione uma opção: 

o Close: Fecha a figura, criando o segmento do ponto atual até o 
primeiro “clique” especificado ao acionar o comando. 

o Undo: Desfaz a última ação do comando Line. 
 

Pressionar ENTER para finalizar o comando. 

 POLYLINE 
Botão Comando Atalho Menu Ribbon 

 

Desenhar 
polilinha 

PL Draw>polyline Home>draw 

O comando POLYLINE cria uma polilinha 2D, um objeto único que é composto 
de segmentos de linha reta, arco ou a associação de ambos. 

PL (ENTER) 
Os seguintes prompts são exibidos: 
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 Specify start point: Especifique o primeiro ponto; 

 Specify next point or [Arc/Halfwidth/Length/Undo/Width]: Especifique o 
próximo ponto ou acione uma opção: 

o Arc: Alterna do modo de criação de segmento de retas para 
segmentos de arcos. 

o Close: Fecha a polyline do último ponto clicado até o primeiro 
ponto clicado. 

o Halfwidth: Permite definir uma espessura para o início e o final 
do segmento da polyline. 

o Length: Permite informar o comprimento para o segmento da 
polyline, dando continuidade à direção definida por último. 

o Undo: Desfaz o último segmento de polyline criado. 
o Width: Permite definir uma espessura para o segmento atual 

da polyline e o que vem a seguir. 

Pressionar ENTER para finalizar o comando. 
 

 RECTANGLE 
Botão Comando Atalho Menu Ribbon 

 
Desenhar 
Retângulo 

REC Draw> rectangle Home> draw 

O comando RECTANGLE cria um retângulo em polilinha, definido por dois 
pontos ou a partir de uma coordenada X,Y. 

REC (ENTER) 
Os seguintes prompts são exibidos: 

 Specify first corner point or [Chamfer/Elevation/Fillet/Thickness/Width]: 
Especifique o primeiro ponto; 

 Specify other corner point or [Area/Dimensions/Rotation]: Clique no 
segundo ponto ou digite uma coordenada cartesiana, 

 ex.: @100,350 (ENTER). 

Pressionar ENTER para finalizar o comando. 

 CIRCLE 
Botão Comando Atalho Menu Ribbon 

 
Desenhar círculo C Draw> circle Home> draw 

O comando CIRCLE cria círculos, desenhados através de várias maneiras 
conforme segue abaixo: 

1. Círculo definido por Centro e Raio ou Diâmetro: 

C (ENTER) 
Os seguintes prompts são exibidos: 



Apostila de AutoCAD 2014 – Técnicas de representações digitais 2D 

UFPR – Departamento de Expressão Gráfica (DEGRAF) – Prof. Márcio Carboni 

19 

 Specify center point for circle or [3P/2P/Ttr (tan tan 
radius)]:Especifique o ponto que será o centro (ENTER); 

 Specify radius of circle or [Diameter] <>: Espefifique o valor do raio ou 
do diâmetro (ENTER). 

Pressionar ENTER para finalizar o comando. 

2. Círculo definido por 2 pontos (2P): 

C (ENTER) 
Os seguintes prompts são exibidos: 

 Specify center point for circle or [3P/2P/Ttr (tan 
tan radius)]:Digite 2P  (ENTER); 

 Specify first end point of circle’s diameter: 
Especifique o ponto que será um dos quadrantes; 

 Specify second end point of circle’s diameter: Especifique o ponto que 
será o quadrante oposto. 

Pressionar ENTER para finalizar o comando. 

3. Círculo definido por 3 pontos (3P): 

C (ENTER) 
Os seguintes prompts são exibidos: 

 Specify center point for circle or [3P/2P/Ttr (tan 
tan radius)]:Digite 3P  (ENTER); 

 Specify first point on circle: Especifique o primeiro ponto da 
circunferência; 

 Specify second point on circle: Especifique o segundo ponto da 
circunferência; 

 Specify third point on circle: Especifique o terceiro ponto da 
circunferência. 

Pressionar ENTER para finalizar o comando. 

4. Círculo definido por 2 pontos tangentes e valor do raio (TTR): 

C (ENTER) 
Os seguintes prompts são exibidos: 

 Specify center point for circle or [3P/2P/Ttr (tan tan radius)]:Digite TTR 
(ENTER); 

 Specify point on object for first tangent of circle: Especifique o primeiro 
ponto tangente ao círculo; 

 Specify point on object for second tangent of circle: Especifique o 
segundo ponto tangente ao círculo; 

 Specify radius of circle: Especifique o raio desejado (ENTER). 
Pressionar ENTER para finalizar o comando. 
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 ARC 
Botão Comando Atalho Menu Ribbon 

 
Desenhar arco A Draw> arc Home> draw 

O comando ARC cria segmentos de linha em arco, através de diversas 
combinações de valores de centro, extremidade, ponto inicial, raio, ângulo, 
comprimento de corda e direção. Seguem abaixo as formas mais usuais de 
desenho de arco. 

1. Arco definido por 3 pontos: 

A (ENTER) 
Os seguintes prompts são exibidos: 

 Specify start point of arc or [Center]: Especifique o primeiro ponto; 
 Specify second point of arc or [Center/End]: Especifique o segundo 

ponto; 
 Specify end point of arc: Especifique o ponto final. 

Pressionar ENTER para finalizar o comando. 

2. Arco definido por início, centro e fim: 

A (ENTER) 
Os seguintes prompts são exibidos: 

 Specify start point of arc or [Center]: Especifique o primeiro ponto; 
 Specify second point of arc or [Center/End]: Digite C (ENTER); 
 Specify center point of arc: Especifique o centro do arco; 
 Specify end point of arc or [Angle/chord Length]: Especifique o ponto 

final. 
Pressionar ENTER para finalizar o comando. 

3. Arco definido por centro, início e fim: 

A (ENTER) 
Os seguintes prompts são exibidos: 

 Specify start point of arc or [Center]: Digite C (ENTER); 
 Specify center point of arc or : Especifique o centro do arco; 
 Specify start point of arc: Especifique o primeiro ponto; 
 Specify end point of arc or [Angle/Direction/Radius]: Especifique o 

ponto final. 
Pressionar ENTER para finalizar o comando. 

4. Arco definido por início, centro e ângulo: 

A (ENTER) 
Os seguintes prompts são exibidos: 

 Specify start point of arc or [Center]: Especifique o primeiro ponto; 
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 Specify second point of arc or [Center/End]: Digite C (ENTER); 
 Specify center point of arc: Especifique o centro do arco; 
 Specify end point of arc or [Angle/chord Length]: Digite A (ENTER); 
 Specify included angle: Especifique o valor para o ângulo (ENTER). 

Pressionar ENTER para finalizar o comando. 

5. Arco definido por início, centro e comprimento de arco: 

A (ENTER) 
Os seguintes prompts são exibidos: 

 Specify start point of arc or [Center]: Especifique o primeiro ponto; 
 Specify second point of arc or [Center/End]: Digite C (ENTER); 
 Specify center point of arc: Especifique o centro do arco; 
 Specify end point of arc or [Angle/chord Length]: Digite L (ENTER); 
 Specify included angle: Especifique o comprimento do arco (ENTER). 

Pressionar ENTER para finalizar o comando. 

6. Arco CONTINUE 

A (ENTER) 
Os seguintes prompts são exibidos: 

 Specify start point of arc or [Center]: (ENTER); 
 Specify end point of arc: Defina o ponto final do arco tangente 

Pressionar ENTER para finalizar o comando. 

 POLYGON 
Botão Comando Atalho Menu Ribbon 

 
Desenhar 
polígonos 

POL Draw> polygon Home> draw 

O comando POLYGON cria polígonos equiláteros com forma bidimensional  
com base no número de lados (3 até 1024 lados). 

POL (ENTER) 
Os seguintes prompts são exibidos: 

 POLYGON Enter number of sides <4>: Especifique o número de 
lados do polígono (ENTER); 

 Specify center of polygon or [Edge]: Especifique o centro; 
 Enter an option [Inscribed in circle/Circumscribed about circle] <I>: 

Escolha “I” ou “C” para o polígono ficar inscrito ou circunscrito no 
círculo de raio definido (ENTER); 

 Specify radius of circle: Especifique o valor do raio (ENTER). 
Pressionar ENTER para finalizar o comando. 
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 ELLIPSE 
Botão Comando Atalho Menu Ribbon 

 
Desenhar elipses EL Draw> ellipse Home> draw 

O comando ELLIPSE cria elipses ou arcos elípticos de 3 formas. 

1. Elipse definida pelo centro 

EL (ENTER) 
Os seguintes prompts são exibidos: 

 Specify axis endpoint of ellipse or [Arc/Center]: Digite C (ENTER); 
 Specify center of ellipse: Especifique o ponto que será o centro da 

elipse; 
 Specify endpoint of axis: Especifique o ponto que definirá o 1º raio 

(semi-eixo); 
 Specify distance to other axis or [Rotation]: Especifique o ponto que 

definirá o 2º raio (semi-eixo). 
Pressionar ENTER para finalizar o comando. 

2. Elipse definida por eixos 

EL (ENTER) 
Os seguintes prompts são exibidos: 

 Specify axis endpoint of ellipse or [Arc/Center]: Especifique o 1º ponto 
que define o 1º eixo (diâmetro); 

 Specify other endpoint of axis: Especifique o 2º ponto que define o 1º 
eixo (diâmetro); 

 Specify distance to other axis or [Rotation]: Especifique o 3º ponto que 
define o outro semi-eixo (raio). 

Pressionar ENTER para finalizar o comando. 

3. Elipse definida por arco elíptico 

EL (ENTER) 
Os seguintes prompts são exibidos: 

 Specify axis endpoint of ellipse or [Arc/Center]: Digite A (ENTER); 
 Specify axis endpoint of elliptical arc or [Center]: Especifique o 1º 

ponto de um dos eixos da elipse ou escolha o centro da elipse; 
 Specify other endpoint of axis: Especifique o 2º ponto de um eixo da 

elipse; 
 Specify distance to other axis or [Rotation]: especifique o outro semi-

eixo (raio); 
 Specify start angle or [Parameter]: Especifique o angulo inicial do arco 

da elipse; 
 Specify end angle or [Parameter/Included angle]: Especifique o ângulo 

final do arco da elipse no sentido anti-horário. 
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 SPLINE (FIT E CV) 
Botão Comando Atalho Menu Ribbon 

 
Desenhar curvas SPL Draw> spline  Home> draw 

 

O comando SPLINE cria uma curva suave que passa através ou perto de um 
conjunto de pontos de ajuste (FIT), ou que é definida por vértices de ajuste 
(CV). Muito usada em construções arquitetônicas, topográficas, estradas, 
produtos e equipamentos.  

 

SPL (ENTER) 
Os seguintes prompts são exibidos: 

 Specify first point or [Method / Degree / Object]: Especifique o 1º 
ponto ou escolha uma opção. Digite M para alterar o método de 
construção da spline e em seguida escolha FIT para definir a spline 
por pontos ou CV para definir por vértices; 

 Specify next pont [Close / Undo]: Especifique o próximo ponto ou 
escolha uma opção. Digite Close para fechar a spline ou Undo para 
desfazer o último ponto ou vértice marcado. 

Pressionar ENTER para finalizar o comando. 

 XLINE 
Botão Comando Atalho Menu Ribbon 

 
Desenhar linha 
de referência  

XL Draw> xline  Home> draw 

 

O comando XLINE cria um segmento de reta infinito na horizontal, vertical ou 
com ângulo. As XLINE podem ser usadas para criar linhas de construção e de 
referência, e para definir limites. 

 

XL (ENTER) 
Os seguintes prompts são exibidos: 

 Specify a point or [Hor/Ver/Ang/Bisect/Offset]: Digite  HOR (ENTER); 
 Specify through point: Especifique o 1º ponto (ENTER). 

Pressionar ENTER para finalizar o comando. 

Nos prompts, são apresentadas as seguintes opções: 
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 Hor - Cria xline horizontal que passa através de um ponto 
especificado pelo usuário. 

 Ver - Cria xline vertical. 
 Ang - Cria xline com ângulo definido pelo usuário. 
 Bisect - Cria várias xlines rotacionando-as pelo centro. 
 Offset - Cópia paralela da xline com o procedimento offset 

simplificado. 

 RAY 
Botão Comando Atalho Menu Ribbon 

 

Desenhar raios 
de referência  

RAY Draw> ray  Home> draw 

O comando RAY cria uma linha que se inicia em um ponto e continua no infinito 
(linha semi-infinita). As linhas que se estendem no infinito em uma direção, 
conhecidas como raios, podem ser usadas como referências para criar. 

RAY (ENTER) 
Os seguintes prompts são exibidos: 

 RAY Especify start point: Especifique o ponto inicial da linha; 
 RAY Especify trough point: Especifique o segundo ponto que definirá 

a linha (ENTER) 
Pressionar ENTER para finalizar o comando. 

  POINT 
Botão Comando Atalho Menu Ribbon 

 
Desenhar pontos PO Draw>Point  Home> draw 

O comando POINT cria um objeto através da inserção de um ponto. 

POINT (ENTER) 
Os seguintes prompts são exibidos: 

 Specify a point: Especifique um ponto.  
Pressionar ENTER para finalizar o comando. 

O estilo de representação do ponto pode ser alterado 
na Ribbon Home> utilities> Point Style, conforme imagem 
abaixo: 
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 DIVIDE 
Botão Comando Atalho Menu Ribbon 

 

Inserir pontos 
(quantidade) 

DIV Draw> divide  Home> draw 

O comando DIVIDE cria objetos ou blocos igualmente espaçados ao longo do 
comprimento ou perímetro de um objeto. A divisão pode ser feita com pontos ou 
com blocos pré-definidos. 

1. Com pontos 

DIV (ENTER) 
Os seguintes prompts são exibidos: 

 Select object to divide: Selecione o objeto a ser dividido; 
 Enter the number of segments or [Block]: Especifique o nº de divisões 

(ENTER). 
Pressionar ENTER para finalizar o comando. 

2. Com blocos 

DIV (ENTER) 
Os seguintes prompts são exibidos: 

 Select object to divide: Selecione o objeto a ser dividido; 
 Enter the number of segments or [Block]: Digite B (ENTER); 
 Enter name of block to insert: Digite o nome do bloco a ser inserido 

(ENTER); 
 Align block with object? [Yes/No] <Y>: Confirme para alinhar os 

blocos ao objeto (ENTER); 
 Enter the number of segments: Especifique o nº de divisões (ENTER). 

Pressionar ENTER para finalizar o comando. 

 MEASURE 
Botão Comando Atalho Menu Ribbon 

 
Inserir pontos 

(espaçamento) 
ME Draw> measure  Home> draw 

O comando MEASURE cria objetos de ponto ou blocos em intervalos 
mensurados ao longo do perímetro de um objeto. Os pontos ou blocos 
resultantes sempre são localizados no objeto selecionado e sua orientação é 
paralela ao plano XY do UCS. A divisão pode ser feita com pontos ou com 
blocos pré-definidos. 

1. Com pontos 

ME (ENTER) 
Os seguintes prompts são exibidos: 

 Select object to measure: Selecione o objeto a ser medido; 
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 Especify lenght of segments or [Block]: Especifique o espaçamento 
entre as divisões (ENTER). 

Pressionar ENTER para finalizar o comando. 

2. Com blocos 

ME (ENTER) 
Os seguintes prompts são exibidos: 

 Select object to measure: Selecione o objeto a ser dividido; 
 Especify lenght of segments or [Block]: Digite B (ENTER); 
 Enter name of block to insert: Digite o nome do bloco a ser inserido 

(ENTER); 
 Align block with object? [Yes/No] <Y>: Confirme para alinhar os 

blocos ao objeto (ENTER); 
 Especify lenght of segments: Especifique o espaçamento entre as 

divisões (ENTER). 

 HATCH 
Botão Comando Atalho Menu Ribbon 

 
Criar hachura H Draw>hatch Home> draw 

O comando HATCH preenche uma área delimitada ou objetos selecionados 
com uma hachura-padrão, preenchimento sólido ou preenchimento de 
gradiente. O AutoCAD possui mais de 50 tipos de hachuras diferentes. 

H (ENTER) 
Os seguintes prompts são exibidos: 

 HATCH pick internal point or [Select objects  setTings]: clique em um 
ponto interno ao objeto que se deseja aplicar a hachura; 

 Select objects: nesta opção, seleciona-se o objeto ao qual será 
aplicada a hachura. 

 setTings: abre-se uma nova tela (caixa de diálogo)  com várias 
opções de ajustes. 

Ao abrir o Settings a caixa a seguir será mostrada: 
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 TYPE AND PATTERN - Define a categoria e o tipo da hachura. 
o Type - Especifica se deve ser criado um padrão de hachura 

predefinido, definido pelo usuário ou personalizado. 
o Padrões predefinidos são armazenados nos seguintes arquivos 

fornecidos com o programa: 
 AutoCAD: acad.pat ou acadiso.pat 
 AutoCAD LT: acadlt.pat ou acadltiso.pat 

o Padrões definidos pelo usuário são baseados no tipo de linha 
atual no seu desenho. Um padrão personalizado é um padrão 
que é definido em qualquer arquivo personalizado PAT que 
você tenha adicionado no caminho de busca.  

 
o Pattern - Exibe uma seleção de padrões de hachura ANSI, ISO 

e outros padrões da indústria. Selecione SOLIDO para criar um 
preenchimento sólido. A opção Padrão ficará disponível 
somente se você definir Type como Predefinido. 

 
o Color - Sobrepõe a cor atual com a cor especificada para os 

padrões de hachura e preenchimentos de sólidos. 
 

o Swatch – é uma pré-visualização (amostra) da hachura 
selecionada. Clique na amostra para exibir a caixa de diálogo 
Paleta de padrão de hachura. 

o Custom pattern - Relaciona os padrões personalizados 
disponíveis. Os padrões mais utilizados recentemente 
aparecem no topo da lista. A opção padrão personalizado 
ficará disponível somente se você definir Type como 
Personalizado. 
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 ANGLE AND SCALE - Especifica um ângulo e uma escala para o 
padrão de hachura selecionado. 

o Angle - Especifica um ângulo para o padrão de hachura em 
relação ao eixo X do UCS atual.  

o Scale - Expande ou reduz um padrão predefinido ou 
personalizado. Esta opção ficará disponível somente se Type 
estiver definido como Predefinido ou Personalizado.  

o Double - Para os padrões definidos pelo usuário, um segundo 
conjunto de linhas a 90 graus das linhas originais, criando uma 
hachura transversal. Esta opção ficará disponível somente se 
Type estiver definido como Definido pelo usuário 

o Relative to paper space - Redimensiona o padrão de hachura 
em relação às unidades do espaço do papel. Isso permite 
exibir padrões de hachura em uma escala apropriada para o 
seu layout nomeado. Esta opção estará disponível somente a 
partir de um layout nomeado. 

o Spacing - Especifica o espaçamento das linhas em um padrão 
definido pelo usuário. Esta opção ficará disponível somente se 
o Type estiver selecionado como Definido pelo usuário (User 
defined).  

o ISO pen width - Define a escala para um padrão predefinido 
ISO com base na largura da caneta selecionada. Esta opção 
ficará disponível somente se Tipo estiver definido como 
Predefinido e Padrão está definido para um dos padrões ISO 
disponíveis. 

 HATCH ORIGIN - Controla a localização inicial da geração da 
hachura padrão. Algumas hachuras, tais como padrões de tijolos, 
necessitam ser alinhados com um ponto no limite de hachura. Por 
definição, toda hachura origem corresponde ao desenho UCS atual. 

o Use current origin - Usa o ponto de origem da hachura 
armazenado na variável de sistema HPORIGIN. 

o Specified origin - Atribui uma nova origem de hachura usando 
as seguintes opções. 

o Click to set new origin - Especifique o novo ponto de hachura 
origem diretamente. 

o Default to boundary extents - Calcula uma nova origem 
baseada na extensão retangular do limite do objeto de 
hachura. Você pode escolher cada um dos quatro cantos da 
extensão e seu centro. (HPORIGINMODE variável de sistema) 

o Store as default origin - Armazena o valor de nova origem da 
hachura. 

 BOUNDARIES - Determina um limite dos objetos existentes que 
formam uma área fechada ao redor de um ponto específico. 

o Add: Pick Points - Determina um limite de objetos 
selecionados que forma uma área fechada. 

o Add: Select Object – Seleciona a área a ser hachurada 
através da seleção de um objeto (ex: polyline, retângulo, 
círculo, etc..) 
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o Remove Boundaries - Remover da definição de limites 
qualquer dos objetos que foram adicionados previamente. 

o Recreate Boundary - Cria uma polilinha ou região ao redor da 
hachura selecionada ou preenchimento e, opcionalmente, 
associa o objeto hachura com a mesma. 

o View Selections - Exibe os limites definidos atualmente com 
as configurações de hachura ou de preenchimento atuais. Esta 
opção estará disponível apenas quando um limite tiver sido 
definido. 

 OPTIONS - Controla vários controles usados para opções de hachura 
ou preenchimentos. 

o Annotative - Especifica que a hachura é anotativa. Esta 
propriedade automatiza o processo de dimensionamento de 
anotações para que elas sejam plotadas ou exibidas com o 
tamanho correto no papel. 

o Associative - Especifica que a hachura ou preenchimento é 
associativa. Uma hachura ou preenchimento que seja 
associativa é atualizada quando você modificam-se os objetos 
que definem seu limite.  

o Create Separate Hatches - Controla se um objeto de hachura 
ou múltiplos hachuras são criadas quando vários limites 
fechados separados são especificados.  

o Draw Order - Atribui uma ordem de desenho a uma hachura 
ou preenchimento. É possível colocar uma hachura ou 
preenchimento atrás de todos os outros objetos (send to back), 
na frente de todos os outros objetos (bring to front), atrás de 
cada limite de hachura (send behind boundary) ou na frente do 
limite de hachura (bring in front of boundary). 

o Layer - Atribui novos objetos de hachura para a camada 
especificada, sobrepondo a camada atual. Selecione Use 
Current para usar a camada atual.  

o Transparency - Define o nível de transparência para novas 
hachuras ou preenchimentos, sobrepondo a transparência do 
objeto atual. 

o Inherit Properties - Aplica hachuras ou preenche limites 
especificados utilizando as propriedades de hachura ou 
preenchimento de um objeto. Após selecionar o objeto de 
hachura cujas propriedades você deseja que a hachura herde, 
pode clicar com o botão direito do mouse na área do desenho 
e utilizar as opções no menu de atalho para alternar entre as 
opções Selecionar objetos e Selecionar pontos internos. 
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 MORE OPTIONS EXPANSION BUTTON - Expande a caixa de 
diálogo Hachura e Gradiente para exibir mais opções. 

 

 Islands 
o Island detection - Liga ou desliga os modos de hachuras. 
o Island display style - Indica o modo usado para hachurar 

objetos internos em relação aos externos. 
 Normal: Insere a hachura, intercalando entre áreas 

hachuradas e não hachuradas. 
 Outer: Não ultrapassa o primeiro limite interno que 

aparecer no desenho. 
 Ignore: A hachura ignora todos os limites. 

 

 

 Boundary retantion 
o Retain boundaries - Liga e Desliga a criação de uma linha 

fronteira (limite), essa linha pode ser polyline ou region no 
momento de criação da hachura. 

o Object type - Escolha entre objeto polilinha ou region. 
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5. RIBBON HOME > MODIFY 
 

 

No menu MODIFY encontram-se as ferramentas de operação entre objetos, de modo 
a facilitar o desenho. 
 

 MOVE 
Botão Comando Atalho Menu Ribbon 

 

mover M Modify Home>modify 

M (ENTER) 
Os seguintes prompts são exibidos: 

 Select object: Selecionar o objeto que se 
deseja mover e clicar ENTER para 
finalizar a seleção; 

 Specify base point or [Displacement]: 
Clique em um ponto de referência 
(verifique se OSNAP está ativo); 

 Specify second point: Clique em um 
segundo ponto ou digite a distância. 

 COPY 
Botão Comando Atalho Menu Ribbon 

 

copiar CO Modify Home>modify 

CO (ENTER) 
Os seguintes prompts são exibidos: 

 Select object: Selecionar o objeto que se 
deseja mover e clicar ENTER para 
finalizar a seleção; 

 Specify base point or [Displacement]: 
Clique em um ponto de referência 
(verifique se OSNAP está ativo); 

 Specify second point or Array: Clique em 
um segundo ponto ou digite a distância. O 
Objeto será copiado múltiplas vezes 
automaticamente, sempre tomando como 
referência o ponto base. O processo é 

 DICA: 

Para todos os comandos, 
procure sempre 
selecionar como ponto 
base um ponto conhecido 
(endpoint, midpoint, 
center, etc.) 

 DICA: 

CTRL+C copia o objeto 
selecionado sem permitir 
que o ponto de inserção 
seja selecionado. 

CTRL+SHIFT+C copia o 
objeto permitindo a 
seleção do ponto de 
inserção. 
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interrompido ao clicar ENTER ou ESC. Selecionada a opção Array 
(A): 

o Enter numbers of itens to array: Quantidade de cópias que se 
deseja fazer do objeto; 

o Specify second point or Fit: selecionar o ponto referente a 
distância entre os objetos copiados ou Fit (F) para selecionar a 
distância final entre o primeiro elemento até a última cópia, 
sendo que o espaçamento entre as cópias será dividido 
automaticamente. 

 ARRAY 
Botão Comando Atalho Menu Ribbon 

 

Matriz AR Modify Home>modify 

 

 

O comando ARRAY possibilita que um determinado objeto seja criado múltiplas 
vezes, de acordo com 3 possibilidades: retangular, path e polar (circular).  

1. RECTANGULAR ARRAY: 

Na opção retangular, pode-se copiar o objeto selecionado através de uma 
matriz composta por linhas, colunas e níveis (versão 3D). Pode-se configurar as 
distâncias entre objetos e/ou a distância total do primeiro ao último objeto 
copiado. 

Ao criar a matriz retangular é aberta a ribbon abaixo:  
 

 
 

 Type > tipo de matriz que será gerada: rectangular, polar or path; 

 COLumns > número de colunas e o espaçamento entre elas; 
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 Rows > número de linhas e o 
espaçamento entre elas; 

 Levels > número de níveis e o 
espaçamento entre eles (usado somente 
em 3D). 

 ASsociative > associa ou não todos os 
objetos a serem replicados como um 
grupo;  

 Base point > altera o ponto de base do objeto; 

 Close Array > fecha a ribbon e salva as alterações. 
 

Ao clicar sobre os objetos da matriz, automaticamente aparecerá a ribbon 
array edit,  que torna possível editar o array como ilustrado abaixo: 

 

 

Além dos itens citados acima, pode-se alterar: 

 Edit source > edita o objeto fonte ou original; 

 Replace item > substitui um dos objetos da matriz por um objeto 
desejado; 

 Reset array > desfaz o passo anterior. 

2. PATH ARRAY 

Através deste comando é possível copiar os objetos por um caminho pré-
determinado (reto ou curvo). 

Ao criar a matriz é aberta a ribbon abaixo: 
 

 
 

 Type> tipo de matriz que será gerada: rectangular, polar or path; 

 Itens> número de itens e o espaçamento entre eles; 

 DICA : 

Quando não associados, 
os objetos serão criados 
sem a possibilidade de 
serem editados 
posteriormente. 
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 Rows> número de linhas e o espaçamento entre elas; 

 Levels> número de níveis e o espaçamento entre eles (usado 
somente em 3D); 

 ASsociative> associa ou não todos os objetos a serem replicados 
como um grupo; 

 Base point> altera o ponto de base do objeto; 

 Tangent direction> especifica a posição do primeiro item em relação 
ao caminho curvo; 

 Measure> distribui as cópias baseado no espaçamento entre os 
objetos ou número de itens; 

 Divide> distribui os itens conforme o comprimento da curva; 

 Align Itens> rotaciona os elementos de acordo com o raio da curva; 

 Close Array> fecha a ribbon e salva as alterações. 

Ao clicar sobre os objetos da matriz, automaticamente aparecerá a ribbon 
array edit,  que torna possível editar o array como ilustrado abaixo: 

 

 

Além dos itens citados acima, pode-se alterar: 

 Edit source> edita o objeto fonte ou original; 

 Replace item> substitui um dos objetos da matriz por um objeto 
desejado; 

 Reset array> desfaz o passo anterior. 

3. POLAR ARRAY 

É possível escolher o número de objetos a serem copiados ou o ângulo 
formado entre eles e o ângulo total a ser preenchido. 
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Ao criar a matriz é aberta a ribbon abaixo: 
 

 

 Type> tipo de matriz que será gerada: rectangular, polar or path; 

 Items> número de itens e o ângulo formado entre eles; 

 Rows> número de linhas e o espaçamento entre elas; 

 Levels> número de níveis e o espaçamento entre eles (usado 
somente em 3D); 

 ASsociative> associa ou não todos os objetos a serem replicados 
como um grupo;  

 Base point> altera o ponto de base do objeto; 

 Rotate itens> rotaciona os itens ao redor do centro escolhido. À 
esquerda, o item foi selecionado e à direita não, conforme ilustração 
abaixo: 

 

 Direction> altera a direção da rotação para sentido horário ou anti-
horário; 

 Close Array> fecha a ribbon e salva as alterações. 

Ao clicar sobre os objetos da matriz, automaticamente aparecerá a ribbon 
array edit,  que torna possível editar o array como ilustrado abaixo: 

 

 

Além dos itens citados acima, pode-se alterar: 

 Edit source> edita o objeto fonte ou original; 
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 Replace item> substitui um dos objetos da matriz por um objeto 
desejado; 

 Reset array> desfaz o passo anterior. 

 ROTATE 
Botão Comando Atalho Menu Ribbon 

 

rotacionar RO Modify Home>modify 

RO (ENTER) 
Os seguintes prompts são exibidos: 

 Select object: Selecionar o objeto que se deseja mover e clicar 
ENTER para finalizar a seleção 

 Specify base point: Clique em um ponto de referência o qual será o 
centro de rotação (verifique se OSNAP está ativo); 

 Specify rotation angle or [copy/reference]: Clique em um segundo 
ponto ou digite o valor do ângulo que se deseja rotacionar. Valores 
positivos de ângulos indicam uma rotação no sentido anti-horário, 
enquanto que valores negativos indicam uma rotação no sentido 
horário, conforme ilustração abaixo: 
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 MIRROR 
Botão Comando Atalho Menu Ribbon 

 

espelhar MI Modify Home>modify 

MI (ENTER) 
Os seguintes prompts são exibidos: 

 Select object: Selecionar o objeto que se deseja mover e clicar 
ENTER para finalizar a seleção; 

 Specify base point or mirror line: Clique em um ponto de referência 
que será o primeiro na formação de um eixo de espelhamento; 

 Specify second point or mirror line: Clique em um segundo ponto, 
formando assim o eixo de espelhamento. O sentido do eixo dará a 
posição do objeto espelhado, conforme a figura abaixo: 

 

 
 

Após criar o eixo de espelhamento, clicar ENTER. Será perguntado se é 
desejado apagar o objeto base. Digitar Y para SIM e N para NÃO e pressionar 
ENTER para finalizar o comando. 

 OFFSET 
Botão Comando Atalho Menu Ribbon 

 

Criar paralelas O Modify Home>modify 

Esta ferramenta é bastante utilizada na construção de paredes, já que cria 
linhas paralelas às dadas. 

O (ENTER) 
Os seguintes prompts são exibidos: 

 Specify offset distance or Trought/ Erase/Layer: digitar o valor da 
distância ou acionar uma das seguintes opções: 

o Trough> neste caso não é utilizada uma distância conhecida; a 
paralela é feita clicando em um determinado ponto.  

1º ponto 

2º ponto 

1º ponto 2º ponto 
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o Erase> selecionada esta opção, pode-se criar a paralela (com 
ou sem uma distância conhecida) e apagar o objeto de origem. 
Feito isso, a cada offset dado o objeto de origem será 
apagado; 

o Layer> altera o layer da paralela criada; ou fica no mesmo 
layer do objeto de origem ou no layer corrente; 

 Select object to offset: Clique no objeto (qualquer ponto) do objeto o 
qual se deseja criar a paralela; 

 Specify point on side to offset: Clique em um ponto qualquer 
indicando em que sentido deseja que a paralela seja criada. Pode-se 
também clicar M (multiple) para criar paralelas continuamente, sem 
sair do comando. 

 FILLET 
Botão Comando Atalho Menu Ribbon 

 

Aparar F Modify Home>modify 

Esta ferramenta também é bastante utilizada na construção de paredes em 
planta, pois possibilita o arremate entre linhas nos cantos. 

F (ENTER) 
Os seguintes prompts são exibidos: 

 Select first object or Undo/ Polyline/ 
Radius/ Trim/ Multiple: clicar em um 
ponto qualquer do primeiro objeto que 
se deseja arrematar ou pode-se 
acionar uma das seguintes opções: 

o Undo> desfaz o último arremate; 
o Polyline> feito o arremate, uma polilinha será criada; 
o Radius> define o raio do arco a ser criado. Na próxima vez que 

o comando fillet for ativado, o arremate será feito com o último 
raio adotado.  

o Trim/ No trim> cria o arco de arremate mantendo ou não as 
linhas originais; 

o Multiple> aplica o comando múltiplas vezes; 

 Select second object or Radius: clicar em um ponto qualquer do 
segundo objeto que se deseja arrematar. 

EXEMPLO: Arrematando paredes em planta 

 

 DICA: 

Com este comando pode-se 
realizar arremates retos, 
bastando indicar o valor do 
raio igual a 0º. 

1

2

3

4



Apostila de AutoCAD 2014 – Técnicas de representações digitais 2D 

UFPR – Departamento de Expressão Gráfica (DEGRAF) – Prof. Márcio Carboni 

39 

Quando aplicado o fillet radius (arremate curvo) um dos arcos não ficará 
paralelo ao outro, sendo necessário aumentar ou diminuir o raio em função da 
espessura da parede, conforme ilustração abaixo: 

 

 
 

 
 

 CHANFER 
Botão Comando Atalho Menu Ribbon 

 

chanfro CHA Modify Home>modify 

CHA (ENTER) 
Os seguintes prompts são exibidos: 

 Select first line or Undo/Polyline/Distance/Angle/Trim/mEthod/Multiple: 
clicar em um ponto qualquer do primeiro objeto que se deseja 
chanfrar ou pode-se usar as seguintes opções: 

o Undo: desfaz o último chanfro; 
o Polyline: feito o chanfro, uma polilinha será criada; 
o Distance: indicar a primeira distância (ex.: 2cm)  e segunda 

distância (ex.:3cm) e em seguida, clicar na primeira e segunda 
linhas, respectivamente, como no exemplo abaixo: 

 

 
 

o Angle: digitar o valor da distância e do ângulo do chanfro; 
o Trim/ No trim: cria o chanfro mantendo ou não as linhas 

originais; 
o mEthod: escolhe o método entre distâncias e ângulos; 
o Multiple: aplica o comando múltiplas vezes. 

 
  

INCORRETO CORRETO

1

2
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 TRIM 
Botão Comando Atalho Menu Ribbon 

 

Cortar TR Modify Home>modify 

Esta ferramenta serve para cortar um determinado objeto até o limite 
selecionado. Também pode ser utilizado para aparar os cantos durante a 
construção das paredes. 

TR (ENTER) 
Os seguintes prompts são exibidos: 

 Select objects or select all: selecionar o 
eixo de corte e clicar ENTER; 

 Select object to trim: selecionar o objeto 
a ser cortado. 

 

OBSERVAÇÃO: 
 O comando só consegue ser aplicado entre linhas que se cruzam. 

 

 EXTEND 
Botão Comando Atalho Menu Ribbon 

 

estender EX Modify Home>modify 

Ao contrário do “trim”, o “extend” estende a linha até o eixo que se deseja. 

EX (ENTER) 
Os seguintes prompts são exibidos:  

 Select objects or select all: selecionar o eixo (até onde se deseja 
esticar o objeto) e clicar ENTER; 

 Select object to extend: selecionar o objeto a ser esticado. 

  

 DICA: 

Uma forma mais prática de 
uso do TRIM é acionar o 
comando e clicar 2 vezes 
no ENTER. Desta forma, 
todos os objetos que se 
interceptam podem ser 
cortados. 

 DICA: 

Os comandos TRIM e EXTEND são opostos. Apertando o SHIFT, ativa-se o comando oposto. 
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 STRETCH 
Botão Comando Atalho Menu Ribbon 

 

esticar S Modify Home>modify 

Uma das ferramentas mais úteis do AutoCAD, pois permite que se estiquem 
objetos (aumentando ou reduzindo) no valor que se deseja. 

S(ENTER) 
Os seguintes prompts são exibidos: 

 Select objects: selecionar os objetos que se deseja esticar e clicar 
ENTER. A caixa de seleção deve ser obrigatoriamente da direita 
para a esquerda. Os objetos que estiverem completamente contidos 
dentro desta caixa serão apenas movidos enquanto os que estiverem 
sendo interceptados pela caixa serão esticados; 

 Specify base point: clicar em um ponto de referência conhecido; 

 Specify second point: clicar em um segundo ponto ou digitar a 
distância que se deseja esticar o objeto e ENTER para finalizar o 
comando. 

OBSERVAÇÃO: 
Deve-se tomar cuidado para não passar a caixa de seleção entre chanfros 
e curvas para que estas não fiquem deformadas, como na ilustração 
abaixo: 
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 SCALE 
Botão Comando Atalho Menu Ribbon 

 

Alterar escala SC Modify Home>modify 

Este comando altera a escala de objetos. É muito utilizada para alterar o 
tamanho do objeto. 

SC(ENTER) 
Os seguintes prompts são exibidos: 

 Select objects: selecionar os objetos que se deseja alterar a escala e 
clicar ENTER; 

 Specify base point: clicar em um ponto de referência conhecido; 
 Specify scale fator or Copy/Reference: digitar o valor da escala ou 

acionar uma das seguintes opções: 
o Copy: não apaga o objeto de origem; apenas cria outro maior 

ou menor dependendo do fator de escala dado; 
o Reference: define o fator de escala através de uma dimensão 

conhecida. 

 EXPLODE 
Botão Comando Atalho Menu Ribbon 

 

explodir X Modify Home>modify 

Este comando transforma objetos compostos em objetos simples. 

X(ENTER) 
Os seguintes prompts são exibidos: 

 Select objects: selecionar os objetos e clicar ENTER.  

Dependendo do objeto selecionado, o comando explode apresenta resultados 
diferentes: 

 Explodindo Polyline: descarta qualquer informação de espessura e 
faz com que os segmentos e arcos que compunham a polyline 
passem a ser objetos individuais; 

 Explodindo Blocos: remove um nível de agrupamento a cada vez. 
Se um bloco contêm polylines ou blocos inseridos dentro de blocos, o 
comando explode expõem a polyline e o bloco, e outro explode expõe 
seus elementos individuais. 
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 ERASE 
Botão Comando Atalho Menu Ribbon 

 

apagar E Modify Home>modify 

Comando que apaga os objetos selecionados. Tem a mesma função da tecla 
Del (deletar) do teclado. 

E(ENTER) 
Os seguintes prompts são exibidos: 

 Select objects: selecionar os objetos e clicar ENTER. 
 

 ALIGN 
Botão Comando Atalho Menu Ribbon 

 

alinhar AL Modify Home>modify 

Este comando é utilizado para alinhar objetos, quando, por exemplo, aparecem 
rotacionados com ângulos desconhecidos ou para alterar as dimensões de um 
objeto. 

  
 

Com este comando também se pode ajustar um objeto à uma medida 
conhecida, alterando sua escala e mantendo suas proporções originais. Para 
isso, se faz o mesmo procedimento descrito acima, apenas clicando em Yes 
quando perguntado se deseja alterar a escala do objeto. 

  

1 

2 

3 

4 
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 BREAK 
Botão Comando Atalho Menu Ribbon 

 

quebrar BR Modify Home>modify 

O comando BREAK quebra o objeto selecionado entre dois pontos, podendo 
apagá-los do desenho ou não. 

BR(ENTER) 
Os seguintes prompts são exibidos: 

 Select objects: selecionar os objetos e clicar ENTER 
 Specify second break point: clicar em um ou mais pontos onde se 

deseja quebrar o objeto, sendo que os trechos quebrados não somem 
do desenho ou First point: seleciona um trecho do objeto para quebrar 
e apagar do desenho. 

 BREAK AT POINT 
Botão Comando Atalho Menu Ribbon 

 

Quebrar em um 
ponto  

Modify Home>modify 

. Similar ao anterior, este comando quebra uma linha no ponto desejado, sem 
apagar trechos da linha selecionada. 

 JOIN 
Botão Comando Atalho Menu Ribbon 

 

unir J Modify Home>modify 

Ao contrário do comando break, JOIN reagrupa linhas e arcos que são 
colineares e coplanares, ou seja, as linhas precisam pertencer à mesma reta e 
não podem estar em alturas diferentes no espaço. 

J(ENTER) 
Os seguintes prompts são exibidos: 

 Select objects: selecionar os objetos e clicar ENTER 
 Select lines to joint o source: selecionar os objetos que deseja unir e 

finalizar o comando. 

 PEDIT 
Botão Comando Atalho Menu Ribbon 

 

Editar polilinha PE Modify Home>modify 

Este comando permite editar polilinhas. 

PEDIT(ENTER) 
Os seguintes prompts são exibidos: 

 Select polylines: clicar sobre a polilinha que se deseja editar;  
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 Aparecem as seguintes opções: 
o Open> abre uma polilinha fechada 
o Join> une segmentos de reta em 

uma única polilinha 
o Width> altera a espessura da 

polilinha 
o Edit vertex> edita os vértices de 

uma polilinha 
o Fit> cria curvas nos cantos da 

polilinha 
o Spline> cria splines a partir de uma polilinha 
o Decurve> desfaz as curvas feitas pelas opções fit e spline 
o Ltype gen> quando desligado, o tipo de linha (linetype) começa 

e termina em cada trecho e quando ligado, ignora os vértices 
da polilinha gerando um padrão contínuo, conforme a 
ilustração: 

 
o Reverse> inverte a ordem dos vértices 
o Undo> desfaz a última alteração feita dentro do comando 

 
  

 DICA: 

Use o Join para unir retas, 
transformando-as em 
polilinhas. 
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6. RIBBON HOME > LAYERS 

Layers são camadas utilizadas na organização do desenho. Através delas, é possível 
atribuir cores, espessuras e tipos de linha para os diferentes objetos inseridos. 

A parte da ribbon (Home) que se refere ao gerenciamento de layers pode ser 
visualizada abaixo: 

 

 

 

 

 

1- Nome do layer; 

2- Cor do layer; 

3- Trancado/destrancado. Quando trancado, fica visível porém com sua cor mais 

escura, não sendo possível editá-lo; 

4- Congelado/descongelado. Quando congelado, fica invisível no desenho; 

5- Ligado/desligado. Quando desligado, desaparece do desenho e não é possível 

editá-lo; 

6- Abre a lista os layers presentes no desenho 

  

6 

1 2 3 4 

5 
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 LAYER PROPERTIES 
Botão Comando Atalho Menu Ribbon 

 
camadas LA Home Home>layer 

Abre uma caixa de diálogo com a relação de layers e suas propriedades. Aqui é 

possível editar/criar novos layers. 

  Current layer: layer corrente ou ativo; 

         Filters: filtra os layers baseado em suas propriedades; 

         New Group Filter: cria um grupo de filtros, com vários níveis, 
independente de seus nomes ou atributos; 

         Layer States Manager: permite recuperar o estado salvo de um 
conjunto de layers (ex.: ligado/desligado; plotar/não plotar, etc); 

         Cria um novo layer; 

         Cria um layer novo e o congela em todas as vistas;                          

         Deleta o layer selecionado; 

         Torna o layer selecionado corrente; 

Em relação a cada layer, além das citadas 
acima, ainda é possível configurar: 

 Linetype: tipo de linha adotado no 
layer; 

 Lineweight: espessura de linha 
adotada no layer; 

 Transparency: transparência 
adotada; 
 

 DICA: 

Deixe sempre a opção 
DEFAULT para a 
espessura da linha. Desta 
forma, a espessura será 
determinada na “table style” 
na hora de imprimir o 
arquivo. 
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 Plot/do not plot: pode-se optar por plotar ou não um determinado 
layer; 

 Plot style: relaciona o layer à uma determinada cor no “table style”. A 
cor definida aqui determinará como a linha sairá na impressão do 
arquivo. 

 MAKE OBJECTS LAYER CURRENT 
Botão Comando Atalho Menu Ribbon 

 Tornar o layer do 
objeto ativo 

LAYMCUR Home Home>layer 

Torna o layer do objeto selecionado corrente. 

 ISOLATE 
Botão Comando Atalho Menu Ribbon 

 isolar LAYISO Home Home>layer 

Esconde ou tranca todos os layers, EXCETO os que pertencem aos objetos 
selecionados. 

 UNISOLATE 
Botão Comando Atalho Menu Ribbon 

 
remove 

isolamento 
LAYUNISO Home Home>layer 

Restaura os layers escondidos ou trancados pelo comando LAYISO. 

 FREEZE 
Botão Comando Atalho Menu Ribbon 

 congelar LAYFRZ Home Home>layer 

Congela o layer dos objetos selecionados. Objetos em layers congelados são 
invisíveis. Em arquivos grandes, esta operação acelera operações como 
regenerar. 

 THAW ALL LAYERS 
Botão Comando Atalho Menu Ribbon 

 descongelar LAYTHW Home Home>layer 

Descongela todos os layers presentes no desenho. 

 OFF 
Botão Comando Atalho Menu Ribbon 

 
desligar LAYOFF Home Home>layer 

Desliga o layer de um objeto selecionado. 
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 ON 
Botão Comando Atalho Menu Ribbon 

 ligar LAYON Home Home>layer 

Liga todos os layers presentes no desenho. 

 LOCK 
Botão Comando Atalho Menu Ribbon 

 trancar LAYLCK Home Home>layer 

Tranca o layer de um objeto selecionado.  

 UNLOCK 
Botão Comando Atalho Menu Ribbon 

 destrancar LAYULK Home Home>layer 

Destranca o layer de um objeto selecionado. 

 CHANGE TO CURRENT LAYER 
Botão Comando Atalho Menu Ribbon 

 
Alterar para layer 

corrente 
LAYCUR Home Home>layer 

Altera os layers dos objetos selecionados para o layer corrente. 

 COPY OBJECTS TO NEW LAYER 
Botão Comando Atalho Menu Ribbon 

 
Copiar objetos para o 

layer corrente 
COPYTOLAYER Home Home>layer 

Transfere o layer de um objeto para outro selecionado e o copia. 

Os seguintes prompts são exibidos: 
 Select objects to copy: selecione os objetos (que terão o layer 

alterado e que serão copiados) e clique ENTER; 
 Select objets on destination layer or Name: selecionar os objetos que 

estão no layer desejado ou N (ENTER) e uma caixa de diálogo com 
os layers listados se abrirá; 

 Specify base point: especificar um ponto de referência; 
 Specify second point: clicar no segundo ponto ou digitar o valor da 

distância. 

 MERGE 
Botão Comando Atalho Menu Ribbon 

  LAYMRG Home Home>layer 

Deleta um layer selecionado, substituindo-o por outro.  

Os seguintes prompts são exibidos: 
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 Select object on layer to merge: selecione o objeto que possui o layer 
a ser substituído (e que será removido do desenho); 

 Select objets on target layer or Name: selecionar os objetos que estão 
no layer desejado ou N (ENTER) e uma caixa de diálogo com os 
layers listados se abrirá; 

 Um diálogo de confirmação aparecerá, digitar sim (Yes) ou não (No) 
para validar. 

 DELETE 
Botão Comando Atalho Menu Ribbon 

 Deletar LAYDEL Home Home>layer 

Deleta todos os objetos contidos em um determinado layer (do objeto 
selecionado ou da lista que se abre). 
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7. RIBBON HOME > PROPERTIES 

 

  

 OBJECT COLOR 
Botão Comando Atalho Menu Ribbon 

 
Cor do objeto COL 

Properties>object 
color 

Home> 
properties 

Esta ferramenta apresenta a palheta de CORES do AutoCAD. Utilizando este 
recurso, pode-se escolher previamente a cor do objeto a ser desenhado ou, 
com o objeto selecionado, pode-se alterar a sua cor. 

 LINEWEIGHT 
Botão Comando Atalho Menu Ribbon 

 
 Espessura da 

linha 
LW 

Properties>linew
eight 

Home> 
properties 

Esta ferramenta apresenta as opções de ESPESSURA de linha do AutoCAD. 
Utilizando este recurso, pode-se escolher previamente a espessura da linha a 
ser desenhada ou, com o objeto selecionado, pode-se alterar a espessura da 
linha. 

 LINETYPE 
Botão Comando Atalho Menu Ribbon 

 
Tipo da linha LT Properties>linetype 

Home> 
properties 

Esta ferramenta apresenta as opções de TIPOLOGIA de linha do AutoCAD 
(ex.:tracejada, traço-ponto, zig-zag, etc...). Utilizando este recurso, pode-se 
escolher previamente o tipo da linha a ser desenhada ou, com o objeto 
selecionado, pode-se alterar o tipo da linha. 

Caso o tipo de linha desejado não esteja disponível na ribbon, deve-se clicar na 
opção Other e a seguinte caixa de diálogo se abrirá: 

Botão de abertura do 
painel de controle 



Apostila de AutoCAD 2014 – Técnicas de representações digitais 2D 

UFPR – Departamento de Expressão Gráfica (DEGRAF) – Prof. Márcio Carboni 

52 

 

Clica-se no botão Load, e a tela para escolha do tipo de linha se abrirá, 
conforme imagem abaixo: 

 

 LTSCALE 
Botão Comando Atalho Menu Ribbon 

 Altera escala da 
linha 

LTS   

Este comando permite aplicar um fator de escala global para todas as tipologias 
de linha do desenho, conforme imagem abaixo: 
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 LIST 
Botão Comando Atalho Menu Ribbon 

 
Listar 

propriedades 
LI Properties>list 

Home> 
properties 

Esta ferramenta apresenta as propriedades do objeto selecionado, como 
coordenadas (X,Y e Z), comprimento, ângulo, layer, área, perímetro, etc... 

 AREA 
Botão Comando Atalho Menu Ribbon 

 Calcular área AA   

Esta ferramenta permite calcular automaticamente a área e o perímetro de um 
objeto, selecionando-o (no caso de uma polyline), ou clicando em seus vértices 
até fechar a poligonal da área a ser calculada.  
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8. RIBBON HOME > UTILITIES 
 

 

 MEASURE 
Botão Comando Atalho Menu Ribbon 

 
Medir ME ou DI Utilities>Measure Home> utilities 

Esta ferramenta permite medir a distância entre dois pontos ou ao longo de uma 
polilinha. 

 QUICKSELECT 
Botão Comando Atalho Menu Ribbon 

 
Seleção filtrada QSELECT Utilities>quickselect Home> utilities 

Esta ferramenta permite uma seleção filtrada, baseada na definição de critérios 
como as propriedades e o tipo dos objetos a serem selecionados. 

Por exemplo, diante da necessidade de selecionar todas as portas de uma 
planta, define-se o layer “PORTA” como filtro e em seguida seleciona-se toda a 
planta. Somente os objetos que estiverem no layer “PORTA” serão 
selecionados. 

 

 SELECT ALL 
Botão Comando Atalho Menu Ribbon 

 
Selecionar tudo AI_SELALL Utilities>selectall Home> utilities 

Esta ferramenta permite selecionar todos os objetos, tanto do model space, 
quanto do layout corrente, com exceção dos objetos contidos em layers 
congelados (frozen) ou trancados (locked). 
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 PURGE 

O comando serve para “limpar” o desenho, retirando tudo que não está sendo 
utilizado, tornando o arquivo mais leve.  

Quando acionado, abre-se a seguinte 
caixa: 

 View items you can purge: exibe os 
objetos que podem ou não ser 
eliminados 

 View items you cannot purge: exibe os 
objetos que não podem ser eliminados 

 Confirm each item to be purged: pede 
uma confirmação a cada item a ser 
removido 

 Purge nested items: remove objetos 
contidos dentro de outros objetos 

 Purge: elimina somente os objetos 
selecionados (ex.: layers) 

 Purge all: elimina todos os objetos que 
não estão sendo utilizados no 
desenho. 

 

 UNITS 
Botão Comando Atalho Menu Ribbon 

 

Definir as 
unidades de 

desenho 
UN Format>Units...  

Esta ferramenta permite definir as unidades do desenho. 
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9. RIBBON HOME > CLIPBOARD 
 

 

 PASTE 
Botão Comando Atalho Menu Ribbon 

 
Colar PASTECLIP Clipboard>Paste Home>clipboard 

Esta ferramenta permite colar objetos selecionados do Clipboard no desenho 
corrente. 

 CUT 
Botão Comando Atalho Menu Ribbon 

 
Recortar CUTCLIP Clipboard>Cut Home>clipboard 

Esta ferramenta permite copiar objetos selecionados para o Clipboard, 
removendo-os do desenho corrente. 

 COPY CLIP 
Botão Comando Atalho Menu Ribbon 

 
Copiar COPYCLIP Clipboard>Copy Clip Home>clipboard 

Esta ferramenta permite copiar objetos selecionados para o Clipboard. 

 MATCH PROPERTIES 
Botão Comando Atalho Menu Ribbon 

 
Copiar 

propriedades 
MA 

Clipboard>Match 
properties 

Home>clipboard 

Esta ferramenta permite aplicar as propriedades de um objeto selecionado em 
outros objetos. É mais comumente conhecida como PINCEL. 

Primeiramente seleciona-se o objeto do qual se quer copiar as propriedades e 
em seguida, selecionam-se os objetos a serem alterados. 
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10. RIBBON INSERT 

Com este menu é possível inserir diversos elementos no plano de trabalho do 
AutoCAD como: blocos, imagens, outros arquivos em .dwg, entre outros. 

 BLOCOS 

O elemento principal e mais utilizado desta ribbon é o bloco. É tão utilizado que 
algumas funções aparecem também na ribbon “home”. 

Um bloco é a combinação de um ou mais objetos de modo a criar um objeto 
único. Blocos são úteis quando é necessário reutilizar objetos no mesmo 
desenho ou em desenhos diferentes. 

Um bloco pode ser composto de objetos desenhados em layers diferentes com 
propriedades diferentes. Pode-se criar blocos associando objetos e atribuindo 
um nome aos mesmos. Pode-se também anexar informações aos blocos, 
também conhecidas como atributos. 

 CREATE BLOCK 
Botão Comando Atalho Menu Ribbon 

 Criar blocos B draw>block>make insert>block 
definition

Cria-se um bloco selecionando os objetos, especificando um ponto de inserção 
e atribuindo um nome ao bloco. O bloco criado pelo comando “Block” existe 
apenas dentro do arquivo (desenho) no qual ele foi criado, ou seja, não é 
exportado como um arquivo com extensão .dwg.  
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 Name > Nome do bloco – o nome pode ter até 255 caracteres e pode 
incluir letras, números, espaços em branco e caracteres especiais. O 
nome e a definição são salvos no desenho corrente. 

 Base point > Define o ponto base de um bloco. 
o Specify On-screen - Permite que sejam especificados os 

objetos/pontos na tela quando esta caixa está ativa, caso 
contrário assume os valores da caixa de diálogo. 

o Pick point – Permite que seja especificado o ponto base 
clicando no desenho. 

 Objects > é possível selecionar quais objetos serão convertidos em 
bloco e o que acontecerá com eles após o término do comando: 

o Retain – os objetos permanecem como estão. 
o Convert to block – serão agrupados virando um bloco. 
o Delete from drawing – serão deletados do desenho. 

 Behavior > definição de alguns comportamentos dos blocos: 
o Annotative – opção usada quando um bloco terá um parâmetro 

anotativo, como escala. 
o Scale Uniformly – com esta opção habilitada não é possível 

fazer alterações com escalas diferentes em XYZ. Os três eixos 
aumentam os diminuem na mesma proporção. 

 Open block editor > Abre o bloco para ser editado no “editor de 
blocos” imediatamente após ser criado. 

Para se criar um bloco separado do 
resto do desenho, ou seja, criar um 
arquivo de AutoCAD que contenha 
apenas aquele objeto (útil para se criar 
uma biblioteca de blocos) existe duas 
possibilidades: 

A primeira seria utilizar o comando “Write a block” (atalho = W). 

 Source > Escolher o que será exportado: 
o Block – Um bloco que está no desenho atual, escolhendo pelo 

nome. 
o Entire drawing – Todo o desenho 
o Objects – Objetos anteriormente selecionados. 

 Objects > é possível selecionar quais objetos serão exportados e o 
que acontecerá com eles após o término do comando: 

o Retain – os objetos permanecem onde e como estão. 
o Convert to block – serão agrupados virando um bloco. 
o Delete from drawing – serão deletados do desenho. 

 DICA: 
Selecione os objetos > ctrl+C > 

ctrl+shift+V. Este comando “cola” os 
objetos copiados como um bloco. 
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 Destination > clicando nas reticências pode-se escolher a pasta onde 
o bloco será salvo e seu nome. 

  

 
A segunda maneira seria selecionando os objetos que deseja exportar para um 
bloco e clicar no “Menu browser” > “Export” > “Other formats” e escolher a 
extensão .dwg (blocks). 

Dependendo do Layer em que for criado o bloco, o mesmo terá 
comportamentos diferentes ao ser inserido em um desenho. Veja as 
características: 

 Bloco criado no layer 0 (zero) > os blocos inseridos adquirirão as 
características do layer corrente, ou do layer para o qual ele for 
alterado. 

 Bloco criado nos demais layers > os blocos inseridos estarão no layer 
inserido, mas os objetos que compõem o bloco permanecerão com as 
propriedades dos layers nos quais se encontravam no momento da 
criação do bloco. 
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 Bloco criado com color/linetype = 
by layer > os objetos assumirão 
a cor/tipo de linha de acordo com 
o layer do qual fazem parte. 

 Bloco criado com color/linetype = 
by block > os objetos assumirão 
a cor/tipo de linha de acordo com 
o layer do bloco. 

 Bloco criado com color/linetype diferente de by layer > o bloco será 
inserido no layer corrente e os objetos irão manter as propriedades 
dos layers que estavam na hora da criação do bloco. 

 INSERT BLOCK 
Botão Comando Atalho Menu Ribbon 

 
Inserir blocos I 

Insert>block ou 
Home>insert 

Insert>block 

 

 Name > Pode escolher pelo nome de um bloco que já exista no 
desenho atual. 

 Browse... > Caso queria importar um bloco novo, basta clicar no botão 
e procurar o diretório do arquivo no computador. 

 Insert point > deixando ligada a opção “specify On-screen” será 
possível clicar no desenho o ponto onde o bloco será inserido. Caso 
esta opção seja desligada é possível digitar a posição com 
coordenadas cartesianas. 

 Scale > Assim como o ponto de inserção é possível clicar no desenho 
um comprimento igual à escala desejada. Entretanto, o mais usual é 
deixar nos campos XYZ o número (1), assim o bloco será inserido 
com o mesmo tamanho que foi desenhado quando criado. 

 DICA: 
Procure sempre que criar 

blocos, deixar os objetos no Layer 0. 
Esta medida evita que, ao se inserir 
um bloco, layers desnecessários 
sejam carregados para dentro do 
arquivo.  
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 Rotation > define o ângulo de rotação do bloco. 

 Explode > deixando esta opção ativa os objetos serão inseridos no 
desenho “explodidos”, ou seja, não como um bloco e sim cada 
elemento separado.  

 BLOCK EDITOR 
Botão Comando Atalho Menu Ribbon 

 Block Editor BEDIT 
Tools>block 

editor 
Insert>block 

O editor de blocos é usado quando é necessário fazer alterações em um bloco 
que já foi criado, sem ser necessário explodir uma instância do bloco e recriá-lo. 
Para entrar no editor de blocos basta dar um duplo-clique no bloco que se 
deseja editar, ou clicar na ferramenta “Block Editor” e selecionar o bloco, 
conforme ilustração abaixo: 

Uma vez dentro do editor pode-se alterar a geometria e demais propriedades 
dos objetos como eram antes do bloco ser criado. Entretanto só estarão visíveis 
os objetos que estiverem dentro deste bloco. 

Depois de editar o bloco, clique no botão “Close Block Editor” e salve as 
alterações quando for solicitado. 
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Note que o “Ribbon” automaticamente vai para o painel “Block Editor”, onde 
aparecem as ferramentas necessárias à edição de blocos. Depois de sair do 
editor retorna-se automaticamente ao Painel do Ribbon que estava sendo 
usado antes da edição. 

 EDIT BLOCK IN-PLACE 

Outra forma possível de se editar blocos é utilizando a função “Edit Block In-place”, 
ou seja, editando o bloco no lugar atual do desenho. Dessa forma não será aberto o editor 
de bloco. 

Este comando é útil quando se deseja editar um bloco tendo referências do desenho 
como um todo. Para isto selecione um bloco, clique sobre ele com o botão direito do 
mouse e selecione Edit Block In-place. 

Após isto apenas os objetos do bloco poderão ser alterados e o restante do desenho 
ficará em um tom mais escuro, como se o comando “Lock Layer” tivesse sido utilizado. 
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Enquanto este comando estiver ativo, nota-se que uma nova Ribbon chamada “Edit 
Reference” aparece com quatro comandos: 

 Save changes > Salva as alterações feitas no bloco e volta para o 
desenho do model. 

 Discard changes > Descarta as alterações feitas no bloco e volta para 
o desenho do model. 

 Add to working set > ao selecionar objetos que não fazem parte do 
bloco e clicar neste comando torna-os parte do bloco. 

 Remove from working set > Ao selecionar objetos pertencentes ao 
bloco e clicar neste comando, retira-os do bloco e se tornam parte do 
desenho no model. 
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  IMAGENS 
Botão Comando Atalho Menu Ribbon 

 

Insert Raster 
Image 

IAT 
Insert>raster 

image reference 
Insert>reference 

Pode-se inserir uma imagem em um arquivo de desenho usando um caminho 
de link de imagem de um diretório do computador ou até mesmo da internet. 

As imagens inseridas funcionam como referências externas, ou seja, a imagem 
não está de fato dentro do desenho. O desenho apenas guarda as informações 
do caminho do arquivo e da sua posição/escala. 

 

 

Para adicionar a imagem clique em “Attach” na Ribbon “Insert”, a seguir 
selecione a imagem a ser inserida. Então abrirá uma janela chamada “Attach 
Image”. Deixando as configurações conforme a imagem acima e clicando em 
“OK” será possível definir o ponto de inserção da imagem no desenho e seu 
tamanho. 

Após a imagem ser inserida, se encontrará no desenho dentro de um contorno 
(retângulo) que ao clicar sobre ele permite editar seu Layer e uma nova Ribbon 
aparecerá. 
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Nesta nova Ribbon é possível fazer algumas edições: 

 Brightness > Ajusta o brilho da imagem. 

 Contrast > Ajusta o contraste da imagem. 

 Fade > Quanto maior o valor mais próximo da cor de fundo a imagem 
ficará 

 Create Clipping Boundary > Permite que seja criado um novo 
contorno para a imagem. Esta função permite que a imagem seja 
“cortada”. Ao acionar o comando a opção original é a de clicar em 
dois pontos indicando um retângulo que será o novo contorno. Antes 
de clicar é possível escolher outras opções: 

o Select polyline > É possível selecionar uma polyline criada 
previamente para ser o novo contorno. 

o Polygonal > Permite desenhar uma poligonal para ser o novo 
contorno. 

o Invert clip > Será removida a parte interna do retângulo criado 
deixando a porção da imagem que estiver por fora aparente. 

 Remove Clipping > Retorna o contorno original da imagem. 

 Show image > Permite “esconder” a imagem deixando aparente 
apenas o contorno. 

 Background Transparency > Permite que objetos atrás da imagem 
fiquem visíveis. 

 External References > Abre o painel de controle das referências 
externas. 
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Outro conjunto de comandos, que se aplica às imagens, altera a apresentação 
do contorno existente. 

Na Ribbon “Insert” > “References” existem 3 comandos que podem ser 
utilizados conforme figura acima: 

 Hide frames > Esconde os contornos, deixando apenas as imagens 
visíveis. 

 Display and plot frames > Deixa os contornos visíveis que serão 
impressos conforme configuração de seus layers ou propriedades de 
linha. 

 Display but don’t plot frames > Deixa os contorno visíveis, porém 
estes não serão impressos. 

Outros cuidados devem ser tomados com relação às imagens de um desenho. 
Para excluir uma imagem do desenho é importante não apenas deletá-la e sim 
removê-la das referências externas. 

Para fazer isto utiliza-se o gerenciador de referências externas com o atalho 
“XR”. Procura-se o nome da imagem e ao clicar com o botão direito usa-se o 
comando “Detach”. 

Além disto, uma vez que a imagem não está de fato dentro do arquivo .dwg 
(apenas sendo refletida dentro do desenho) é importante tomar o cuidado de 
não deletá-la ou alterar o diretório do arquivo (imagem).  
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11. RIBBON ANNOTATE 

 

Nesta ribbon encontram-se os comandos de texto, cotas, indicações, tabelas e 
marcações. 

 TEXTOS 

A parte da ribbon que se refere a textos pode ser visualizada abaixo: 

 

 1 – Seleciona as formas com as quais o texto pode ser desenhado: 
texto simples ou de múltiplas linhas; 

 2 – Seleciona o estilo do texto. Clicando na seta, temos a opção 
Manage Text Styles, que abrirá a caixa de diálogo de criação de 
novos estilos; 

 3 – Seleciona a altura padrão dos textos que serão criados de acordo 
com o estilo selecionado. 

 Scale: altera a escala do texto; 

 Justify: altera o alinhamento do texto; 

 Check Spelling: corretor ortográfico; 

 Find text: encontra uma determinada palavra em todo desenho ou 
dentro de uma prancha no layout ativo, ou ainda na seleção feita. 
Tem-se a opção de substituir algumas ou todas as palavras 
encontradas por outras. 

Através do item 1 do menu anterior ou dos atalhos abaixo, pode-se desenhar 
textos: 

  

1 

2 

3 
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 TEXT 
Botão Comando Atalho Menu Ribbon 

 

Texto simples T Text Annotate>text 

 Cria um texto com uma única linha e opções limitadas de edição. 

 MTEXT 
Botão Comando Atalho Menu Ribbon 

 

Texto múltiplas 
linhas 

MT Text Annotate>text 

 Desenha uma caixa de texto com múltiplas linhas sendo possível editá-la 
alterando as opções na seguinte caixa de diálogo: 

 

 

 Style: mostra os diferentes estilos criados pelo usuário; 
 Formating: altera tipo de fonte e efeitos (negrito, itálico, sublinhado); 
 Paragraph: altera o alinhamento do texto (justificado, 

centralizado,etc); 
 Insert: insere colunas e símbolos; 
 Spell Check: edita o dicionário a ser usado pelo corretor ortográfico; 
 Tools: achar e substituir textos (também aparece resumido no menu 

de texto principal). 

Através do item 2 do menu pode-se editar o estilo do texto, abrindo a caixa de 
dialogo abaixo: 

 

 Set current: deixa o estilo desejado ativo; 
 New: cria um novo estilo de texto 
 Delete: deleta um estilo, caso este não esteja em uso; 
 Font: seleciona o tipo e estilo da fonte (itálico, negrito, etc); 
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 Size: configura a altura da fonte; 
 Effects: inclui efeitos na fonte, tais como: 

o Upside down: vira o texto de cabeça para baixo; 
o Backwards: inverte o texto; 
o Width Factor: deixa a fonte escolhida mais larga; 
o Oblique Angle: deixa a fonte escolhida oblíqua no ângulo 

desejado. 

 COTAS 

A parte da ribbon que se refere à cotas pode ser visualizada abaixo: 
 

 

1 – Seleciona as formas com as quais as cotas podem ser desenhadas:  

 Linear: cria cotas em linha reta; 

 Aligned: cria cotas para linhas inclinadas; 

 Angular: cria cotas de ângulos; 

 Arc Length: cria cota referente ao perímetro de arcos; 

 Radius: cria cota referente ao valor do raio de arcos; 

 Diameter: cria cota referente ao diâmetro do arco ou círculo; 

 Jogged: cria cotas com linhas de interrupção para arcos e 
círculos; 

 Ordinate: cria cotas ordenadas, referentes às distância x,y de um 
ponto base dado. 

2 – Seleciona/lista o estilo da cota. Clicando na seta, aparecem as opções de 
estilo criadas; 

3 – Editar/criar novos estilos. 
  

1 

2 

3 
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 BREAK 
Botão Comando Atalho Menu Ribbon 

 

Quebrar 
dimensão 

DIMBREAK Annotate annotate>dimensions

Quebra a linha de extensão quando a cota cruza outro objeto, conforme 
ilustração: 

 

 ADJUST SPACE 
Botão Comando Atalho Menu Ribbon 

 

Ajustar espaço DIMSPACE Annotate annotate>dimensions

Ajusta o espaço entre as linhas de cota. 

Os seguintes prompts são exibidos: 
 Select base dimension: clicar na cota base; 
 Select dimensions to space: selecionar as demais cotas e dar 

ENTER; 
 Enter value: digitar o valor da distância entre as cotas. 
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 QUICK DIMENSION 
Botão Comando Atalho Menu Ribbon 

 Cota rápida QDIM Annotate annotate>dimensions 

Rapidamente cria cotas para o objeto selecionado. 

Os seguintes prompts são exibidos: 
 Select geometry to dimension: clicar no(s) objetos(s) que se deseja 

cotar; 
 Specify dimension line position: especificar a posição da linha de cota 

ou selecionar uma das opções: 
o Continuos> cria todas as cotas alinhadas; 
o Staggered>cria cotas estratificadas, das menores para as 

maiores, conforme ilustração: 

 
o Baseline> cria cotas subsequentes, a partir de um ponto de 

origem, conforme ilustração: 

 
o Ordinate> cria dimensões indicando a coordenada absoluta 

(em relação ao 0,0) dos pontos em um eixo (x ou y), conforme 
ilustração: 
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o Radius> cria cotas referentes aos raios dos arcos e círculos 
selecionados; 

o Diameter> cria cotas referentes aos diâmetros dos arcos e 
círculos selecionados; 

o datumPoint> cria dimensões indicando as coordenadas dos 
pontos em um eixo (x ou y) a partir de um ponto de referência 
(assinalado), conforme ilustração: 

 
 

 CONTINUE 
Botão Comando Atalho Menu Ribbon 

 continuar DIMCONTINUE Annotate annotate>dimensions 

Cria uma cota na sequência de outra criada anteriormente. 
Os seguintes prompts são exibidos: 

 Select continued dimension: selecionar a cota que se deseja continuar 
e teclar ENTER. 

 DIMJOGLINE 
Botão Comando Atalho Menu Ribbon 

 
Linha de 

interrupção  
DIMJOGLINE Annotate annotate>dimensions

Insere uma linha de interrupção na cota. 

 UPDATE 
Botão Comando Atalho Menu Ribbon 

 
Alterar estilo da 

cota 
 Annotate annotate>dimensions

Atualiza as cotas selecionadas para o estilo corrente. 

 DIMENSION STYLE MANAGER 
Botão Comando Atalho Menu Ribbon 

 estilo da 
cota 

DDIM Annotate annotate>dimensions 

Edita/cria estilos de cota, abrindo a caixa de dialogo a seguir: 
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 Styles: lista os estilos do desenho 
 List: filtra todos os estilos ou somente os que estão em uso 
 Preview: mostra o aspecto final do estilo selecionado 
 Set Current: deixa o estilo selecionado corrente 
 New: cria um novo estilo de cota 
 Modify: modifica um estilo de cota a partir de um existente 
 Override: altera temporariamente um estilo existente 
 Compare: compara dois estilos listando suas propriedades diferentes. 

Ao clicar em modify ou new, abre-se a caixa de diálogo a seguir, sendo 
possível configurar o estilo da cota de acordo com as propriedades. 

OBSERVAÇÃO: 
As principais propriedades a serem definidas no estilo da cota são: 
 
 

 

 
 

  

EXTENSION LINE

DIMENSION LINE 

ARROW HEAD 

OFFSET FROM 
ORIGIN 

OFFSET FROM DIMLINE 

EXTEND BEYOND 
TICKS 

EXTEND BEYOND 
DIMENSION LINE 



Apostila de AutoCAD 2014 – Técnicas de representações digitais 2D 

UFPR – Departamento de Expressão Gráfica (DEGRAF) – Prof. Márcio Carboni 

74 

Lines – linhas 
Dimension lines: são as linhas que ficam 
embaixo do texto da cota. Pode alterar a cor, 
tipo de linha e espessura e ainda suprimir 
parte da linha. 
Extend beyond ticks: prolonga as linhas de 
extensão; 
Baseline spacing: distância entre as cotas 
do tipo “baseline”. 
Extension lines: são as linhas de extensão 
dos objetos cotados. Pode-se alterar a cor, 
tipo de linha e espessura e ainda suprimir as 
linhas de um lado ou de outro. 
Extend beyond dim lines: prolongamento da 
linha de dimensão; 
Offset from origin: distância do texto em 
relação à linha de dimensão; 
Fixed lenght: fixa o comprimento da linha de 
extensão. 
 
Symbols and Arrows – símbolos e setas 
Arrowheads: define o aspecto das 
extremidades das linhas de dimensão; 
Arrow size: tamanho da seta; 
Center marks: tamanho e tipo da marcação 
de centros para arcos e círculos; 
Break size: define a medida da quebra 
quando acionado o comando (DIMBREAK); 
Arc length symbol: define a posição da 
marcação do comprimento de arcos; 
 
 
Text - texto 
Text appearance: aparência do texto, 
podendo ser atrelado um estilo pré-definido, 
altera cor, preenchimento e altura. 
Text placement: posição do texto em relação 
às linhas de dimensão; 
Offset from origin: distância entre o texto e a 
linha de dimensão; 
Text alignment: define o alinhamento do 
texto: 
Horizontal: sempre horizontal; 
Aligned with dimension line: alinhado à 
linha de dimensão; 
ISO standard: alinha o texto à linha de 
dimensão quando o texto está compreendido 
entre as linhas de extensão ou alinha 
horizontalmente quando o texto está fora das 
linhas de extensão. 
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Fit – Ajuste 
Fit Options: define as opções do aspecto final 
da cota quando o texto não cabe entre as 
linhas de extensão. Neste caso, pode-se 
deixar o texto ou as marcações da cota ou 
ambos fora do espaço compreendido entre as 
linhas de extensão; 
Text placement: caso o texto não fique na 
posição padrão, pode-se deixá-lo ao lado da 
linha de dimensão ou acima da linha, com ou 
sem uma seta; 
Fine tuning: pode-se posicionar o texto 
manualmente ou desenhar uma linha de 
dimensão entre as linhas de extensão. 
 
 
Primary Units – Unidades  
Linear dimensions: define o sistema métrico 
a ser utilizado, precisão da cota (quantas casa 
decimais), separação decimal (ponto, vírgula 
ou espaço) e se haverá prefixo ou sufixo. 
Scale factor: define um fator de escala ao 
valor real da dimensão cotada. 
Angular dimensions: define o sistema 
métrico e precisão da cota utilizada em arcos 
e círculos. 
Zero supression: retira o zero, sendo: 
Leading: antes do separador decimal (ex.: 
0.5º aparece como .5º) 
Trailing: depois do separador decimal (ex.: 
45,00º aparece como 45º) 
 

 INDICAÇÕES (LEADERS) 

A parte da ribbon que se refere às indicações pode ser visualizada abaixo: 

 

 
 

1- Lista os estilos de indicação; 

2- Editar/criar novos estilos ou digitar o atalho a seguir. 
 

  

1 

2 
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 MLEADERSTYLE 

Através deste atalho pode-se editar o estilo das linhas de chamada, textos e 
setas. Abrem-se as seguintes caixas de diálogo: 

 
Styles: lista os estilos do desenho; 
List: filtra todos os estilos ou somente os 
que estão em uso; 
Preview: mostra o aspecto final do estilo 
selecionado; 
Set current: deixa o estilo desejado ativo; 
New: cria um novo estilo; 
Modify: modifica um estilo existente; 
Delete: deleta um estilo, caso este não 
esteja em uso. 
 
 

 
Leader Format - formatação das linhas guia 
Type: selecionar entre linha reta, curva ou 
nenhuma; 
Color: altera a cor da linha de chamada; 
Linetype: altera o tipo de linha; 
Lineweight: altera a espessura; 
Arrowhead: altera o estilo da seta e o tamanho; 
Leader break: interrompe as linhas em 
determinados pontos; 
Break size: tamanho da quebra. 
 
 
 
 
Leader Structure – estrutura das linhas 
guias 
Maximum leader points: máximo de cliques 
até que apareça o campo de digitação do texto; 
First segment angle: 1º ângulo segment; 
Second segment angle: 2º ângulo do 
segment; 
Automatically include landing: inclui a linha 
automaticamente; 
Set landing distance: define o valor da 
distância da linha de chamada; 
Scale: deixe sempre o valor 1. 
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Content – conteúdo da indicação 
Multileader type: define o tipo de conteúdo da 
indicação: texto de múltiplas linhas ou bloco; 
Text options: selecionar estilo de texto, 
ângulo, cor e tamanho; 
Leader connection: define como o texto se 
conecta à linha de chamada; 
Landing gap: distância do texto à linha de 
chamada; 
Extend leader to text: estende ou não a linha 
de chamada ao longo do texto. 
 
 
 

 MULTILEADER 
Botão Comando Atalho Menu Ribbon 

 Multi indicações MLEADER Annotate annotate>leaders 

Cria uma nova indicação no ponto selecionado. 

 ADD LEADER 
Botão Comando Atalho Menu Ribbon 

 
Adicionar 
indicação 

MLEADEREDIT Annotate annotate>leaders 

Adiciona uma nova linha à uma indicação existente. 

 REMOVE LEADER 
Botão Comando Atalho Menu Ribbon 

 
Remover 
indicação 

MLEADEREDIT Annotate annotate>leaders 

Ao contrário do add leader, remove linhas criadas de uma indicação existente. 

 ALIGN LEADERS 
Botão Comando Atalho Menu Ribbon 

 
Alinhar 

indicações 
MLEADERALIGN Annotate annotate>leaders 

Alinha as indicações selecionadas. 

 COLLECT 
Botão Comando Atalho Menu Ribbon 

 coletar 
MLEADERCOLL

ECT 
Annotate annotate>leaders 

Reúne as indicações selecionadas para uma única indicação. 
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 ANNOTATIVE SCALE 

A escala anotativa é uma ferramenta muito prática para configurar textos e 
cotas para que fiquem sempre com o tamanho correto independente da escala 
utilizada. Para isso deve-se configurar um estilo de cotas e textos com a opção 
annotative ativada. Após isso três ferramentas são utilizadas e se encontram 
na barra de status: 

 

 

 1 – Annotation Scale: Mostra a escala que está ativa. Toda cota ou 
texto que for criada será configurada para esta escala. A grande 
vantagem de se utilizar Annotative Scale é que se a escala for 
alterada e a cota, por exemplo, estiver configurada para mais de uma 
escala, ela automaticamente se ajusta (seu tamanho) para a nova 
escala. 

 Para isso, deve-se inicialmente configurar as escalas que se irá 
utilizar. Clicando na seta para baixo da ferramenta Annotation Scale 
são exibidas as escalas existentes e a palavra Custom... É aqui que 
se configura ou edita as escalas. Aparecerá a seguinte janela: 

 
o Add: Adiciona uma nova escala. Deve-se nomear 

a escala (p.e.: 1:50) e em Scale properties deve-se 
configurar Paper Units: 1 = Drawing Units: 5 (no caso da 
escala 1:50). Isso se deve a unidade do papel ser em 
milímetros e o desenho estar em centímetros. 

o Para facilitar utilizar a tabela da página 89. 
o Edit: Edita-se escalas existentes. 
o Delete: Deleta a escala selecionada. 

 

 2 – Annotation Visibility: Com este botão ligado os objetos de todas 
as escalas são exibidos. Se desligado, somente os objetos (cotas, 
textos, indicações) da escala ATIVA serão exibidos. 

1 2 3 
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 3 – Automatically add scale to annotative objetcts when the 
annotation scale changes: Com este botão ligado quando muda-se 
a escala anotativa automaticamente os objetos incorporam a escla 
selecionada em suas propriedades, dessa forma o tamanho de cotas 
é alterado quando muda-se a escala. Nem sempre isto é desejado já 
que pode-se ter desenhos em diferentes escalas. Por isso é mais 
usual deixar desligado. Quando estiver desligado pode-se adicionar 
escala aos objetos selecionando-os, digitando MO (janela de 
propriedades) e clicando no ícone “...” conforme imagem abaixo: 
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12. RIBBON OUTPUT 

 

Nesta Ribbon encontram-se opções para impressão do desenho seja em papel 
(plotagem) ou em arquivo PDF. 

Existem algumas maneiras de criar uma folha, diagramá-la e finalmente imprimir um 
desenho. Nesta apostila serão explicadas duas maneiras: no model e no layout. 

 CRIANDO UMA PRANCHA NO MODEL 

 

Model é chamada a área de desenho do AutoCAD e nela busca-se sempre 
desenhar os modelos em escala real, seja em centímetros ou metros, por 
exemplo. 

Para diagramar uma folha com os desenhos, inicialmente é preciso desenhar as 
pranchas com os respectivos tamanhos. É usual trabalhar com os tamanhos 
definidos pelas normas da ABNT (A4, A3, A2, A1 e A0). 

 

A4 210 x 297 mm 
A3 297 x 420 mm 
A2 420 x 594 mm 
A1 594 x 841 mm 
A0 841 x 1189 mm 
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Desenha-se no model uma folha com suas dimensões em milímetros. É normal 
que ela fique pequena em relação ao desenho se estiver sendo desenhado em 
centímetros. A escala do desenho será dada aplicando o comando “SCALE” 
na FOLHA. 

É importante observar que deve se evitar a mudança da escala do desenho, 
pois dificultará futuras alterações, já que ele não estará mais em verdadeira 
grandeza.  

A escala que deve ser dada depende da unidade que se está desenhando. 
Partindo sempre da prancha desenhada em milímetros (ou seja, um A4 deve 
ser um retângulo de 210x297), se desejar que o desenho fique na escala 1:50 a 
folha receberá um “SCALE” de “5” caso esteja trabalhando em centímetros, e 
“0,05” caso esteja trabalhando em metros. Veja tabela abaixo que demonstra 
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qual o fator de escala que deverá ser aplicado à folha de acordo com a unidade 
em que se está desenhando o projeto: 

 

FATOR DE ESCALA 

ESCALA mm cm m 

1:5 5 0.5 0.005 

1:10 10 1 0.010 

1:50 50 5 0.050 

1:75 75 7.5 0.075 

1:100 100 10 0.1 

1:125 125 12.5 0.125 

1:1000 1000 100 1 

Feito isto, basta diagramar a folha posicionando os desenhos, textos, imagens, 
etc. 

 PLOT 
Botão Comando Atalho Menu Ribbon 

 
Plot PLOT Filet>plot output>plot 

 

Ao aplicar o comando “PLOT” algumas opções referentes à plotagem podem 
ser configuradas: 

 Page Setup – Configurações de página: 



Apostila de AutoCAD 2014 – Técnicas de representações digitais 2D 

UFPR – Departamento de Expressão Gráfica (DEGRAF) – Prof. Márcio Carboni 

83 

o Name > Exibe uma lista de opções de plotagem pré-
configuradas. 

o Add > Adiciona uma nova configuração. 

 Print/Plotter – Impressora: 
o Name > Escolhe-se a impressora ou plotter que será utilizada. 
o Plot to file > Esta opção deve estar ativada caso queira criar 

um arquivo “.PLT” (arquivo de impressão). 

 Paper Size - Mostra os tamanhos padrões de papéis disponíveis para 
a impressora ou plotter escolhida. 

 Number of copies - Define o número de cópias a serem impressas. 

 Plot area > What to plot - Área do desenho a ser impressa: 
o Display > Imprime a porção do desenho apresentada na tela. 
o Extents > Imprime todos os objetos contidos na tela. 
o Limits > Plota os limites determinados pelo Limits do usuário. 
o Window > Especifica uma área a ser plotada no model space. 

 Plot offset – Permite afastar o desenho da borda da página 
o X > Permite afastar com uma distância determinada de X. 
o Y > Permite afastar com uma distância determinada de Y. 
o Center the plot > Centraliza o desenho da página. 

 Plot Scale – Permite configurar a escala do desenho: 
o Fit to paper > Enquadra a área do desenho a ser impressa no 

tamanho limite do papel selecionado. Observar que nesta 
opção não se pode definir a escala do desenho. 

o Scale > Trabalha com uma unidade de escala predefinida. 
o Custom > Permite que seja definida a escala de plotagem. No 

caso de uma plotagem via layout deixar escala 1:1. No caso 
de uma plotagem via model deve-se definir a escala da 
mesma forma dada na prancha no Model Space. Deixando o 
primeiro campo em “mm” e com o valor “1” e o segundo 
conforme a tabela abaixo, de acordo com a unidade de 
desenho. 

 

FATOR DE ESCALA 

ESCALA mm cm m 

1:5 5 0.5 0.005 

1:10 10 1 0.010 

1:50 50 5 0.050 

1:75 75 7.5 0.075 

1:100 100 10 0.1 

1:125 125 12.5 0.125 

1:1000 1000 100 1 
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 Plot style table – Configura o estilo de penas para plotagem (cores e 
espessuras das linhas, de acordo com os layers): 

o acad.ctb > Impressão colorida, conforme os layers. 
o Dwf virtual pen.ctb > Pena virtual, imprime todos os desenhos 

com a mesma espessura. 
o Fill Patterns.ctb > Cada pena terá um tipo de preenchimento 

diferente. 
o Grayscale.ctb > Imprime em tons (escala) de cinza. 
o Monochrome.ctb > Usa somente uma cor (preto). 
o Screening 25%,50%,75%.ctb > Porcentagem de tinta na saída 

de impressão. 

 Shade plot - Indica a forma de apresentação do desenho. 
o As displayed > Imprime e apresenta o desenho de acordo com 

a visualização do model space. 
o Wireframe > Imprime e apresenta o desenho com todas as 

linhas aparentes. 
o Hidden > Imprime e apresenta o desenho com linhas de 

construção ocultas. 
o Rendered > Imprime e apresenta o desenho renderizado. 

 Quality - Controla a qualidade de apresentação de um desenho. 
o Draft > Apresenta os objetos com resolução de 

aproximadamente zero (0) DPI. 
o Preview > Mostra o objeto com resolução de50 DPI. 
o Normal > Mostra os objetos com uma resolução de 100 DPI. 
o Presentation > Mostra os objetos com boa qualidade de 

resolução (aproximadamente 200 DPI). 
o Maximum > Mostra os objetos com uma resolução de 200 DPI 

na qualidade máxima. 
o Custom > Configura a impressão em DPIs para se obter uma 

alta qualidade, mínimo de 100 DPI e no máximo de 1200 DPI. 
o DPI (Dots per inch) > Pontos por polegada (ppp), é uma 

medida de densidade relacionada à composição de imagens, 
que expressa o número de pontos individuais que existem em 
uma polegada linear na superfície onde a imagem é 
apresentada. 

 Plot Options – Opções de plotagem: 
o Plot in background > Imprime em segundo plano. 
o Plot object lineweights > Imprime as espessuras de linhas de 

um objeto. 
o Plot with plot styles > Imprime com estilos adotados pelos 

objetos. 
o Plot paperspace last > Plota os objetos do Model Space antes 

dos objetos do Paper Space. 
o Hide paperspace object > Oculta as linhas dos desenhos em 

3D. 
o Plot stamp on > Imprime uma estampa com o caminho, data e 

nome do arquivo, ou dados personalizados. 
o Save changes to layout > Salva as mudanças do Layout. 
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 Drawing orientation - Indica qual a orientação do desenho na página 
para a plotagem: 

o Portrait > Permite que o desenho fique em posição retrato 
(vertical). 

o Landscape > Permite que o desenho fique em posição de 
paisagem (horizontal). 

o Upside-down > Permite que o desenho seja impresso de 
cabeça para baixo. 

Após definir todas as configurações é importante clicar em “APPLY TO 
LAYOUT” para que estas configurações sejam salvas. Caso saia do quadro de 
diálogo de plotagem, ao acionar novamente o comando “PLOT”, todas as 
configurações já estarão da forma como definida anteriormente. 

 CRIANDO UMA PRANCHA NO LAYOUT 

Criar uma prancha no layout possui algumas vantagens principalmente se 
houver mais de um desenho na mesma prancha com escalas diferentes. 

 
 

Ao lado da aba “MODEL” existe a aba “LAYOUT1”. Ao clicar com o botão 
direito sobre ela aparecerá a janela de opções acima onde é possível criar um 
novo layout, deletar, renomear, ordenar (quando existir mais de um), entre 
outras opções. 

Inicialmente temos que configurar o layout como se fosse configurada a página 
na plotagem em model. Após clicar com o botão direito > Page Setup 
Maneger... 
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O “Page Setup Maneger” mostrará todos os layouts do desenho e seus 
respectivos detalhes. 

Para editar o primeiro layout clique em “*Layout1* > Modify...” 

 

Se abrirá o menu de configuração de plotagem, com os mesmos campos 
explicados no comando “PLOT”. Deve-se configurar a impressora que será 
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utilizada, o tamanho do papel, o tipo de penas, e a diferença está no campo 
“Plot scale”. Deve ser configurada a escala 1:1, pois no layout,ao contrário da 
plotagem a partir do model space, a folha permanecerá em escala real (em 
milímetros) e o desenho que sofrerá mudança de escala. 

Após este procedimento já é possível trabalhar no Layout. O passo seguinte é 
desenhar uma prancha de acordo com o tamanho escolhido anteriormente, ou 
copiar (com Ctrl+C / Ctrl+V) uma prancha já existente e posicioná-la dentro da 
folha branca delimitada pelo AutoCAD. Outra opção é, após desenhar ou copiar 
a folha, voltar ao menu “Page Setup Maneger” e alterar de layout para 
“window” em “Plot area”, e selecionar exatamente o contorno da folha 
desenhada. 

 VIEWPORT 
Botão Comando Atalho Menu Ribbon 

 Viewport MV ou VP 
View>Viewports>

1 Viewport 
Layout>layout 

viewports 

Viewport é uma janela que mostra o 
desenho feito no Model Space. Pode-se 
criar quantas forem necessária na mesma 
prancha. Por exemplo, pode-se criar uma 
viewport para cada peça gráfica, como 
cada planta ou cada corte. 

A partir da Ribbon layout pode-se criar 
uma viewport retangular, poligonal ou a 
partir de um objeto (polyline, por exemplo) 
previamente desenhado. 

Utilizando o atalho no teclado “MV” 

algumas opções são apresentadas no 
campo de diálogo do AutoCAD: 

 Specify corner of viewport - 
Escolha dois pontos em 
diagonal para a criação de uma 
janela retangular. 

 ON - Ativa uma Mview (janela de plotagem) selecionando sua borda. 
Ao ativar a Mview o desenho volta a aparecer. 

 OFF - Desativa a Mview (janela de plotagem) através da seleção de 
sua borda. Ao desativar, os desenhos desaparecem. 

 Fit - Cria uma Mview (janela de plotagem) contornando todo o seu 
layout. 

 DICA: 
As viewports criadas devem ficar 

no “layer viewport”. Desta forma o 
contorno não será impresso. 
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 Shadeplot: 
o As displayed - Plota o desenho, exatamente como está sendo 

visualizado. 
o Wireframe - Plota o desenho mostrando todas as linhas 

(aramado). 
o Hidden - Plota o desenho ocultando todas as linhas de 

projeção. 
o Visual Styles - Abre as opções de “Visual Styles” para a 

plotagem. 
o Rendered - Plota o desenho renderizado. 

 Lock - Tranca a Viewport para que a escala não seja alterada por 
acidente. Deve ser feito imediatamente após definir a escala da 
Viewport. 

 Object - Seleciona um objeto (polyline) para servir de Mview. 

 Polygonal - Gera a Mview com um polígono, definido através de 
pontos na tela. 

 Restore - Restaura a configuração da Mview salva pelo comando 
Mview. 

 2 - Cria duas Mviews conjugadas. 

 3 - Cria três Mviews conjugadas. 
o Horizontal - Cria três janelas na horizontal. 
o Vertical - Cria três janelas na vertical. 
o Above - A maior janela será inserida na parte superior. 
o Below - A maior janela será inserida na parte inferior. 
o Left - A maior janela será posicionada à esquerda. 
o Right - A maior janela será posicionada à direita. 

 4 – Cria quatro Mviews conjugadas. 

 ZOOM SCALE 
Botão Comando Atalho Menu Ribbon 

 
Zoom scale Z 

View>Zoom>Scal
e 

View>Navigate 
2D 

Como já citado, ao criar uma diagramação no Layout (também chamado de 
Paper Space), a folha sempre estará em verdadeira grandeza (em milímetros) e 
o desenho que sofrerá modificação de escala. Esta escala é dada com o 
“Zoom scale” através de uma opção chamada “ZOOM XP” dentro da 
viewport. Desta forma o desenho feito no Model Space não será realmente 
modificado, apenas sua vista será ajustada de forma que a escala fique 
adequada ao papel. Esta opção calcula uma unidade de escala por várias 
unidades de espaço do papel. 
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Para isto, primeiramente necessita-se dar um “duplo-clique” com o botão 
esquerdo dentro da viewport. Então “Z>Enter” e digitar “10/100xp”, por 
exemplo, se desejar uma escala de 1:100 e desenhando em centímetros. 

Este número utilizado deve ser de acordo com a tabela abaixo, sempre 
utilizando “xp” após o número: 
UNIDADE 

DE 
DESENHO 
(MODEL) 

1:25 1:50 1:100 1:125 

mm 1 25 1 50 1 100 1 125 
cm 10 25 10 50 10 100 10 125 
m 1000 25 1000 50 1000 100 1000 125 
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